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SOFTWARE LICENSE AGREEMENT

INSTALLING OR OTHERWISE USING THIS SOFTWARE PRODUCT CONSTITUTES YOUR ACCEP-
TANCE OF THE FOLLOWING TERMS AND CONDITIONS (UNLESS A SEPARATE LICENSE IS PRO-
VIDED BY THE SUPPLIER OF APPLICABLE SOFTWARE IN WHICH CASE SUCH SEPARATE LICENSE
SHALL APPLY). IF YOU DO NOT ACCEPT THESE TERMS, YOU MAY NOT INSTALL OR USE THIS
SOFTWARE, AND YOU MUST PROMPTLY RETURN THE SOFTWARE TO THE LOCATION WHERE
YOU OBTAINED IT.

THE SOFTWARE INSTALLED ON THIS PRODUCT INCLUDES NUMEROUS INDIVIDUAL SOFTWARE
COMPONENTS, EACH HAVING ITS OWN APPLICABLE END USER LICENSE AGREEMENT (“EULA”).
INFORMATION RELATING TO THE EULAS MAY BE FOUND IN AN ELECTRONIC FILE INCLUDED ON
THE USER DOCUMENTATION CD-ROM INCLUDED HEREWITH; HOWEVER, ALL SOFTWARE AND
DOCUMENTATION DEVELOPED OR CREATED BY OR FOR TOSHIBA TEC CORPORATION (“TTEC”)
ARE PROPRIETARY PRODUCTS OF TTEC AND ARE PROTECTED BY COPYRIGHT LAWS, INTERNA-
TIONAL TREATY PROVISIONS, AND OTHER APPLICABLE LAWS.

Grant of License

This is a legal agreement between you, the end-user (“You”), and TTEC and its suppliers. This software,
fonts (including their typefaces) and related documentation (“Software”) is licensed for use with the system
CPU on which it was installed (“System”) in accordance with the terms contained in this Agreement. This
Software is proprietary to TTEC and/or its suppliers.

TTEC and its suppliers disclaim responsibility for the installation and/or use of this Software, and for the
results obtained by using this Software. You may use one copy of the Software as installed on a single Sys-
tem, and may not copy the Software for any reason except as necessary to use the Software on a single
System. Any copies of the Software shall be subject to the conditions of this Agreement.

You may not, nor cause or permit any third party to, modify, adapt, merge, translate, reverse compile,
reverse assemble, or reverse engineer the Software. You may not use the Software, except in accordance
with this license. No title to the intellectual property in the Software is transferred to you and full ownership is
retained by TTEC or its suppliers. Source code of the Software is not licensed to you. You will be held legally
responsible for any copyright infringement, unauthorized transfer, reproduction or use of the Software or its
documentation.

Term

This license is effective until terminated by TTEC or upon your failure to comply with any term of this Agree-
ment. Upon termination, you agree to destroy all copies of the Software and its documentation.

You may terminate this license at any time by destroying the Software and its documentation and all copies.

Disclaimer of Warranty

THIS SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND NON-INFRINGEMENT. TTEC AND ITS SUPPLI-
ERS DISCLAIM ANY WARRANTY RELATING TO THE QUALITY AND PERFORMANCE OF THE SOFT-
WARE. IF THE SOFTWARE PROVES DEFECTIVE, YOU (AND NOT TTEC OR ITS SUPPLIERS) SHALL
BE RESPONSIBLE FOR THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORREC-
TION. TTEC AND ITS SUPPLIERS DO NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE
SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE
WILL BE UNINTERRUPTED OR ERROR FREE.

ALL INFORMATION CONTAINED HEREIN THAT IS PROVIDED BY TTEC AND ITS AFFILIATES PURSU-
ANT TO A EULA IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED.
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Limitation of Liability

IN NO EVENT WILL TTEC ORITS SUPPLIERS BE LIABLE TO YOU FOR ANY DAMAGES, WHETHER IN
CONTRACT, TORT, OR OTHERWISE (EXCEPT PERSONAL INJURY OR DEATH RESULTING FROM
NEGLIGENCE ON THE PART OF TTEC OR ITS SUPPLIERS), INCLUDING WITHOUT LIMITATION ANY
LOST PROFITS, LOST DATA, LOST SAVINGS OR OTHER INCIDENTAL, SPECIAL OR CONSEQUEN-
TIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF TTEC
OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, NOR FOR
THIRD PARTY CLAIMS.

U.S. Government Restricted Rights

The Software is provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the U.S. Govern-
ment is subject to restrictions set forth in subdivision (b) (3) (ii) or (c) (i) (ii) of the Rights in Technical Data
and Computer Software Clause set forth in 252.227-7013, or 52.227-19 (c) (2) of the DOD FAR, as appropri-
ate. Contractor/Manufacturer is TOSHIBA TEC Corporation, 6-78, Minami-cho, Mishima-shi, Shizuoka-ken,
411-8520, Japan.

General

You may not sublicense, lease, rent, assign or transfer this license or the Software. Any attempt to subli-
cense, lease, rent, assign or transfer any of the rights, duties or obligations hereunder is void. You agree that
you do not intend to, and will not ship, transmit (directly or indirectly) the Software, including any copies of
the Software, or any technical data contained in the Software or its media, or any direct product thereof, to
any country or destination prohibited by the United States Government. This license shall be governed by
the laws of Japan or, at the election of a Supplier of TTEC concerned with a dispute arising from or relating
to this Agreement, the laws of the Country designated from time to time by the relevant Supplier of TTEC. If
any provision or portion of this Agreement shall be found to be illegal, invalid or unenforceable, the remain-
ing provisions or portions shall remain in full force and effect.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE AGREEMENT AND THAT YOU UNDER-
STAND ITS PROVISIONS. YOU AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU FUR-
THER AGREE THAT THIS LICENSE AGREEMENT CONTAINS THE COMPLETE AND EXCLUSIVE
AGREEMENT BETWEEN YOU AND TTEC AND ITS SUPPLIERS AND SUPERSEDES ANY PROPOSAL
OR PRIOR AGREEMENT, ORAL OR WRITTEN, OR ANY OTHER COMMUNICATION RELATING TO THE
SUBJECT MATTER OF THIS LICENSE AGREEMENT.

TOSHIBA TEC Corporation, 6-78, Minami-cho, Mishima-shi, Shizuoka-ken, 411-8520, Japan.
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Preface

Thank you for purchasing the TOSHIBA multifunctional digital system e-STUDIO165/205.

This Network Fax Guide is a manual for the e-STUDIO165/205 when the both of the following
options are installed:

* Network Printer Kit, Fax Kit and External Keyboard

This Network Fax Guide describes how to fax data from your computer using the Network Fax
Driver and the Address Book Viewer.

Be sure to read this manual before using the e-STUDIO165/205 with the options above. Keep
this manual handy and retain it for future reference.

Preface 5
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Lineup of Our Manuals

These manuals are provided for the operation of the e-STUDIO165/205. Select and read the
manual best suited to your needs.

TOSHIBA

Operator's Manual
for Copying Functions

I=:s1upiol65/205

Quick Start Guide for
Printing Function

I=s1upiol65/205

TOSHIBA

Network Administration
Guide for Printing
Functions

I=supiol65/205

TOSHIBA

Setup Guide for
Printing Functions
I=subiol65/205

TOSHIBA

Printing Guide
Zs1upiol65/205

Operator’s Manual for Copying Functions

This manual describes the basic operations, mainly copying functions,
of this equipment. It also describes safety precautions to ensure cor-
rect and safe use of this equipment. Be sure to read this before you
use the equipment.

Quick Start Guide for Printing Functions

This manual describes the operation of the equipment when the Net-
work Printer Kit (optional) is installed on it. This also explains about the
accessories, conditions required for network systems, connecting
method of the network, general description of network settings and
troubleshooting.

Network Administration Guide for Printing Functions (PDF)

This manual is only for the equipment on which the Network Printer Kit
(optional) is installed. This provides you with setup procedures by the
type of platforms or networks you are utilizing, and also setup proce-
dures for network servers to enable various network services.

Setup Guide for Printing Functions (PDF)

This manual is only for the equipment on which the Network Printer Kit
(optional) is installed. The manual consists of the following 2 parts:
Settings Using Control Panel

This part describes the printer-related settings using the [PRINTER]
and [USER FUNCTIONS] buttons on the control panel of this equip-
ment.

Settings Using TopAccess

This manual describes how to set up this equipment from your com-
puter through a network using a web-based utility TopAccess. This also
explains about functions to check the current status of this equipment.

Printing Guide (PDF)

This manual is only for the equipment on which the Network Printer Kit
(optional) is installed. This describes how to install client software for
printing data to your computer. This also describes how to print data
sent from your computer to this equipment.
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Network Fax Guide (PDF) (This manual)

This manual is only for the equipment on which the Fax Kit (optional),
the External Keyboard (optional) and the Network Printer Kit (optional)
are installed. This explains about the network Fax functions, which
enable Fax transmissions from a client computer through a network.

TOSHIBA

Network Fax Guide
I=swpiol65/205

To read manuals in PDF (Portable Document Format) files

Viewing and printing this operator’s manual in PDF files require that you install Adobe Reader or
Adobe Acrobat Reader on your PC. If Adobe Reader or Adobe Acrobat Reader is not installed
on your PC, download and install it from the website of Adobe Systems Incorporated.

Lineup of Our Manuals 7
Download from Www.Somanuals.com. All Manuals Search And Download.



Before Reading This Manual

Precautions in this manual

To ensure correct and safe use of this equipment, this operator's manual describes safety pre-
cautions according to the three levels shown below.

You should fully understand the meaning and importance of these items before reading this
manual.

- Indicates a potentially hazardous situation which, if not avoided, could result
in death, serious injury, or serious damage, or fire in the equipment or sur-
rounding assets.

. Indicates a potentially hazardous situation which, if not avoided, may result in
minor or moderate injury, partial damage of the equipment or surrounding
assets, or loss of data.

Indicates a procedure you should follow to ensure the optimal performance of
the equipment and problem-free copying.

Other than the above, this manual also describes information that may be useful for the opera-
tion of this equipment with the following signage:

Describes handy information that is useful to know when operating the equip-

ment.
| Pages describing items related to what you are currently doing. See these

pages as required.
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Trademarks

* The official name of Windows 98 is Microsoft Windows 98 Operating System.

¢ The official name of Windows Me is Microsoft Windows Me Operating System.

* The official name of Windows 2000 is Microsoft Windows 2000 Operating System.

¢ The official name of Windows XP is Microsoft Windows XP Operating System.

¢ The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating
System.

¢ Microsoft, Windows, Windows NT, and the brand names and product names of other
Microsoft products are trademarks of Microsoft Corporation in the US and other countries.

* Apple, AppleTalk, Macintosh, Mac, TrueType, and LaserWriter are trademarks of Apple
Computer Inc. in the US and other countries.

* Postscript is a trademark of Adobe Systems Incorporated.

* Netscape is a trademark of Netscape Communications Corporation.

¢ IBM, AT and AlX are trademarks of International Business Machines Corporation.

¢ NOVELL, NetWare, and NDS are trademarks of Novell, Inc.

¢ Other company names and product names in this manual are the trademarks of their respec-
tive companies.

©2006 TOSHIBA TEC CORPORATION All rights reserved

This manual is protected by copyright laws. No part of this manual shall be duplicated or repro-
duced without the permission of TOSHIBA TEC CORPORATION. TOSHIBA TEC CORPORA-
TION shall not be liable in terms of granting patents for any use of information contained in this
manual by third parties.
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OVERVIEW

This section describes about the overview of the network fax features.
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Features and Functions

The network fax functions of this equipment allow you to make direct fax transmission of elec-
tronic documents from your computer. The fax documents are transmitted from the computer to
this equipment through a network, and then this equipment transmits them to outside fax
machines through public switched telephone networks.

To enable the network fax functions, you must install the Network Fax Driver and the Address
Book Viewer from the attached Client Utilities CD-ROM.

When you fax hard copies, not electronic documents, fax them using the control panel of this
equipment.

Fax transmission using the Network Fax Driver is available only when both the Network
Printer Kit (optional), the Fax Kit (optional) and the External Keyboard (optional) are installed.

Features

Network Fax Driver

When the Network Fax Driver is installed, you can transmit electronic documents as fax data
from your computer to several destinations.

When you fax documents, you can easily set the list for the destinations or the resolution of
the fax data.

When you fax documents, you can attach an embedded cover sheet on them. Information
about the fax documents and their detailed messages can be included in this cover sheet.
The destinations of the fax can be entered manually, or can be selected from the address
book data by running the Address Book Viewer. In this method, you can easily search for the
desired addresses throughout the address book.

Since the image data processing methods for network fax documents and regular fax docu-
ments differ, the image quality for network fax documents may vary compared with that for
regular fax documents.

Address Book Viewer

The data of the various address books including the one for this equipment can be managed.
The address book data of the other devices can be converted into a format which is retriev-
able in this equipment.
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Functions

The general descriptions of the Network Fax Driver and the Address Book Viewer are shown
below.

Network Fax Driver

The Network Fax Driver allows you to make fax transmission of documents created in your com-
puter. In a normal procedure, select the [Print] menu in the application in which the documents
were created, select this driver (TOSHIBA e-STUDIO205 Series Fax), and then start printing.
The documents are then transmitted to this equipment. This equipment then transmits the docu-
ments to outside fax machines through public switched telephone networks, using the Fax Kit
(optional) and the External Keyboard (optional).

In fax transmission using the Network Fax Driver, you can enter the destination of the fax manu-
ally or retrieve the desired destinations from the address book data of the Address Book Viewer.

Address Book Viewer

The Address Book Viewer is the managing software for address books. With the Address Book
Viewer, you can use the local address book of your computer or the LDAP address book of an
LDAP server. Also the address books of this equipment and those of other compatible TOSHIBA
equipment can be used as a public address book. The Address Book Viewer also allows you to
add or edit the destinations in the address books by the recipient or the group.

The address book data conversion function of the Address Book Viewer allows you to import
and export address book data in a CSV format so that the created address book data can be
shared effectively.

Client computer (Windows 98 / Me / 2000 / XP / Server 2003)

Applications
Document
Document data
- Network Fax Driver —>
7~ |(Transmits document data as a fax)

Destination searching Network

Y

Local address book Address Book Viewer

LDAP address book
Public address book,etc. <::> (Manages address books)

<
Address book data

G3 Facsimile

Features and Functions 15
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INSTALLING CLIENT SOFTWARE

This section describes the instructions on how to install the client software for the network fax features.
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Installing Network Fax Software

This chapter describes how to install the software required for fax transmission from this equip-
ment and for using various address books. It is recommended that you read this chapter in its
entirety before the installation.

Overview

Before you can begin utilizing the network fax feature for this equipment, you must install the
software using the Client Utilities CD-ROM provided. You will use the InstallShield client soft-
ware setup process.This section describes the way to add Network Fax Driver and Address
Book Viewer to user’s workstations.

System requirements

The Network Fax Driver and Address Book Viewer are available for the following environments:
* Display resolution
1024 x 768 dots or more
* Display color
High Color (16bit) or higher is recommended
* CPU
Pentium 133 MHz minimum (Pentium 266 MHz or faster recommended)
* Memory
64MB for Windows 98
96MB for Windows Me and Windows NT 4.0
128MB for Windows 2000/XP/Server 2003
* OS
Windows 98 (Windows 98 Second Edition Recommended)
Windows Me
Windows NT 4.0 Service Pack 6a
Windows 2000 Service Pack 4
Windows XP Service Pack 1
Windows Server 2003

Before installing client software

Before installing the client software, confirm the following to perform an appropriate installation.

— Checking if the Address Book Viewer has been installed

If the Address Book Viewer has bee installed from either the Client Utilities CD-ROM or Client
CD-ROM for e-STUDIO3510c Series, e-STUDIO451¢ Series, e-STUDIO850 Series, e-
STUDIO452 Series, e-STUDIO282 Series, e-STUDIO4511 Series, e-STUDIO450 Series, or e-
STUDIO280 Series, you do not have to install it again. The Address Book Viewer can be used
commonly.

If you want to install Network Fax Driver and Address Book Viewer from this CD-ROM, uninstall
the existing Network Fax Driver and Address Book Viewer then reinstall it using this Client Utili-
ties CD-ROM. When you uninstall the Address Book Viewer, please click [No] at the dialog box
that displays the message to delete the settings for the Address Book Viewer so that you can
restore the settings after installing the new Viewer.

18 Installing Network Fax Software
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Installing the Network Fax Driver and Address Book Viewer

You can install the Network Fax Driver and Address Book Viewer from the Client Utilities CD-
ROM.

This section describes about installing the Network Fax Driver and Address Book Viewer in a
Raw TCP environment.

Installing from Client Utilities CD-ROM

This section describes how to install fax client software under Raw TCP environments through
TCP/IP, using an installer.

The Network Fax Driver can be set up using the same connection as a printer driver such as,
USB printing, LPR printing, IPP printing, and Novell printing. To set up the Network Fax Driver
using these connections, please refer to the Printing Guide.

To set up the Network Fax Driver in other than Raw TCP environment, see the Printing Guide.

Installing the fax client software for Raw TCP connection using the installer

The procedure presented here describes the installation to Windows 2000 using the installer.
The procedure is the same when Windows XP or Windows Server 2003 is used. (The Network
Fax Driver can also be installed using the Add Printer wizard. Please see the Printing Guide.)

Before installing the printer driver in a Raw TCP environment, confirm the following:
* This equipment is connected to the network and turned on.
* The TCP/IP setting is correct on this equipment and your computer.

You must log into Windows as a user who has “Administrators” or “Power Users” privileges
when using the Windows 2000, Windows XP, or Windows Server 2003.

Insert the Client Utilities CD-ROM into the CD-ROM drive.

* The installer automatically starts and the Choose Setup Language dialog box
appears.

* When the installer does not automatically start, double-click “Setup.exe” in the Client
Utilities CD-ROM.

2 Select your language and click [OK].
=

@ Select the languadge for the installation from
! i the choices below.

lish

The Welcome to the InstallShield wizard screen is displayed.

Installin% Network Fax Software 19
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3 Click [Next].
Installshield Wizard x|

‘Welcome to the InstallShield Wizard for Toshiba
e-5TUDIDZ05 Series

The InstallS hield® Wizard willinstal Toshiba
&5 TUDIO205 Series on your computer. Ta continue,
click Mext.

<Beok [FRERST] Canel |

The License Agreement screen is displayed.

4 Please read the license agreement carefully and click [Yes].

Toshiba e-STUDID205 Series - InstallShield Wizard

License Agreement
Pleaze read the following license agreement carefully.

Press the PAGE DOWN key to see the rest of the agreement.

EMD USER SOFTWARE LICENSE AGREEMEMT -
INSTALLING OR OTHERWISE USING THIS SOFTWwaRE PRODUCT CONSTITUTES
'YOUR ACCEPTANCE OF THE FOLLOWING TERMS AMD COMDITIONS [IMLESS &
SEPARATE LICENSE IS FROVIDED BY THE SUPPLIER OF APPLICAELE SOFTWARE

IN *HICH CASE SUCH SEPARATE LICENSE SHALL APPLY). IF vOU DO NOT

(ACCEPT THESE TERMS, YOU MAY NOT INSTALL OR IISE THIS SOFTWARE. AND
YOL MUST PROMPTLY RETURM THE SOFT'WARE TO THE LOCATION WHERE

YO OBTAINED IT.

GRANT OF LICENSE. =

Do you accept all the terms of the preceding License Agreement? | you select Mo, the setup
will close. To install Toshiba e-5TUDIO205 Series, you must accept this agieement

IrstallSHield

<Back Yes Ne |

The Choose Destination Location screen is displayed.

5 Click [Next].

Toshiba e-STUI

Choose Destination Location
Select falder where setup will instal files.

Setup will install Tashiba e-5 TUDIO20S Series in the following folder.

To install to this folder, click Next. To install to a different folder, click Browse and select
another folder.

LA ATOSHIBANT oshiba e-5 TUDIO205 Series Erowse..

st Shield

" Diestination Folder

< Back Cancel |

If you want to change where the programs are installed, click [Browse]. In the dialog box
appears, select the folder and click [OK].

The Setup Type screen is displayed.

20 Installing Network Fax Software
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6 Select “Custom” and click [Next].

Toshiba e-STUDIDZ05 Series - InstallShield Wizard 5‘

Selup Type \
Select the Setup Type to Instal \

Click the type of Setup you prefer, then click Mext

 Typical Prograrn will be installed with the most common options. Recommended
for most users.

" Complate Program will be installed with all options.

‘You may choose the aptions pou want to install. Aecommended for
advanced users.

I 7stalStie!d

< Back Hew> | Concel |

The Select Components screen is displayed.

7 Check the software that you want to install and click [Next].

Toshiba e-STUDIDZ05 Series - InstallShield Wizard ﬂ

Select Components '’
Select the components sstup wilinstal

Select the components you want to install, and deselect the components you do not want to
inztall

Toshiba e-5TUDIOZ05 Series PCLE i
i[] Tasshiba e-5TUDIDZ05 Series PSLI S%‘#ES;‘HSE‘;QM Tashiba
iha - 4 e eries
Toshiba e STDZDS Series NAWFax b v e
computer.

fa TrueType Fonts

< (|
18.68 ME of space required on the C diive
876232 MB of space available on the C diive

by

< Back Mest > I Cancel |

Toshiba e-STUDIO205 Series N/W-Fax: Check this to install the Network Fax Driver.
Toshiba e-STUDIO205 Series AdressBookViewer: Check this to install the Address
Book Viewer.

The Select Port screen is displayed.
Tip

The names of other printing software, besides the above two, are displayed in the Select
Components dialog box. (You can install them as required.)

Installin% Network Fax Software 21
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Since the installer detects this equipment and the name of this
equipment is displayed at “Devices on Network”, select it and then
click [Next].

TOSHIBA e-STUDIO205 Series Client

Select Port
Select the port for printer.

Tupe the network name ar Queue name of vour device. IF you don't know the name, select the device
from the list of available devices on the network.

Network path or quews name ||p71 00100100101
& Devices on Metwork
[ 1Paddress | Location | PRINTER TPE |
100.100.100.101 TOSHIBA e-STUDIOZ0S
" Local Pott

<Back | Next> I Cancel I

The Select Program Folder screen is displayed.

If this equipment is not properly connected in your network, the message that the installer
cannot discover this equipment is displayed.

Message

Devices are not discovered in your network.. To Retry searching for devices, press Retry. To
Cantinue ta use the Default part or Shared Printer, press Cantinue. For infarmation, press
Information,

{Eontne | Rery | Information |

If you want manually to configure the port for printing, click [Continuel].
Then, select “LPT1:” in the drop down box at “Local Port” and click [Next].

TOSHIBA e-STUDID205 Series Client

Select Port
Select the port for printer.

Tupe the network name or Quele name of vour device. If you don't know the name, select the device
from the list of available devices on the network.

Netwark path or queus name ILp-n

" Devices on Metwark

Printer Mame | IPAddiess | Location | PRINTER TYPE |

@ Local Port

LPT1 -

<Back | Next> I Cancel I

After selecting the port “LPT1:”, follow the steps described below to complete installation.
However, in this case, you need to manually configure the Raw TCP port after the com-
pletion of installation.

22
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9

10

Click [Next].

Toshiba e-STUDID205 Series - InstallShield Wizard 5‘

Select Program Folder \
Please select 5 program folder A

Setup will add program icons to the Program Falder listed below. ‘Yo may type a new folder
name, or select one fiom the existing folders list. Click Mext to continue.

Ero Fold

Exgisting Folders:

Adrministrative Tooks
Startup

IrstallShield

< Back Het> | Concel |

If you want to change the program folder, rename the folder in the “Program Folder” field.

The Start Copying Files screen is displayed.
Click [Next].

Toshiba e-STUDID205 Series - InstallShield Wizard

Start Copying Files
Feview settings before copying fles.

Setup has snough information to start copying the program fles. IF you want ta review r
change any setings. click Back. If you are satisfied with the seflings. click Next to begin
copying fles

Current Settings:

TARGET DIRECTORY: ;I
C:\Program Filesh\TOSHIBAAT oshiba e-STUDID20S Series

Toshiba e-STUDIDZ05 Series AddressE ookiewer

The following components will be installed to System Folder.
Toshiba e-5TUDIOZ205 Series NAw-Fax

LOCAL DRIVER PORT:

IP_100.100.100.101 =
: _’l_I

IrstallShield

<Back Cancel |

Starts copying files and the InstallShield Wizard Complete screen appears when this is

completed.

When you select to install the Network Fax Driver, the Digital Signature Not Found dialog
box is displayed while files are being copied. Click [Yes] to continue the installation.

Installin
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11 Click [Finish].

Toshiba e-STUDID205 Series - InstallShield Wizard

InstallShield Wizard Complete

The Install5 hield 'wizard has successfully installied T oskiba
eSTUDIOZ05 Series. Before you can use the program, pou
st restart your computer

& Hes, T want to restait my computer now.
Mo, | wil restart my computer later

Remove any disks fiom their diives, and then click Finish to
complete setup.

< Back Fish | | Coeel |

The installation is completed.
The Installer may ask you to restart your computer. If it does, select “Yes, | want to restart
my computer now.” and click [Finish] to restart your computer.

When you select “LPT1:” in the Select Port screen, you need to configure the Raw TCP
port. Proceed to the following page:
P.24 “Configuring the Raw TCP/LPR port for Windows 2000/XP/Server 2003”

Configuring the Raw TCP/LPR port for Windows 2000/XP/Server 2003

This configuration is not necessary when the installer automatically discovers this equipment.
Manually configure the Raw TCP/LPR port only when you manually select “LPT1:” port at “Local
Port” in the Select Port screen.

1 Click [Start], select [Settings], and click [Printers] to open the Print-
ers folder.

% Windows Undate

% Set Program Access and Defauits

Programs 4

N (= Control Panel

Metwork and Dialup Connections  *
B printers
i Taskbar  Start Menu...

E Shut Down, ..
[stare || ] @ 5 ||
If you are using the Windows XP or Windows Server 2003, click [Start] and [Printers and
Faxes] to open the Printers and Faxes folder.

24 Installing Network Fax Software
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2 Select the Fax driver and select [Properties] in the [File] menu.

_ioix|
|[Fle  Edt View Favories Tools Help ‘
| EeRen bearch (yFolders @History | S TS b5

| v Set as Default Prinker x| @a
—  Printing Preferences. ..
L

(e b - 1
Pause Printing “

Cancel All Documents Add Printer

Sharing...
Use Printer Offline

Server Properties

Create Shortcut
Delete:
Rename Fax
S T =141 3
Clase —I
\Coromprryre-proprermeroroe selected items.

A

The printer driver properties dialog box appears.

3 Display the [Ports] tab and click [Add Port].

&% TOSHIBA e-STUDIO205 Fax Properties 2lx|

General| Sharing Potts | Advanced | Color Management | Secury | About |

G

& TOSHIBA e-5TUDIOZ05 Fax
]

Frinit to the following portfs). Documents will print to the first free
checked port.

Part Description Printer =

Fiinter Fort
CILPTZ:  Printer Port
CILPT3:  Printer Port
O coMt: Seial Part
O oMz Seial Port
Ocomz  Seial Part
O coM4: Serial Part =l

AddFot.. Delete Port Configure Pot.. |

™| Enizble bidirectional support
[~ Enable printer pooling

oK I Cancel I Lpply | Helm

The Printer Ports dialog box appears.

Select “Standard TCP/IP Port” and click [New Port...].

Awalable port Eypes:

Local Part

New Port Typs... | HewPort... |  Cancel |

The Add Standard TCP/IP Printer Port Wizard dialog box appears.
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5 Click [Next].

IP Printer Port Wizard 3 x|

Welcome to the Add Standard
TCP/IP Printer Port Wizard

“ou use this wizard to add a poit for a network printer
Eefore continuing be sure that:

1. The device is tumed on
2. The network is connected and configured

To continue, click Next.

B [ Wewts | Cancel |

Enter the IP address of this equipment in the “Printer Name or IP

Address” field and click [Next].

Add Standard TCP/IP Printer Port Wizard x|
Add Port 4
For which device do you want to add a port?
e

Enter the Printer Mame or IP address, and & port name for the desired device:

Printer Name or IP Address: 101070105

Port Name: |ﬁ_1 0107010

<Back [ Nest> |  Cancel |

* If your network uses a DNS or WINS server, enter the printer name of this equipment
provided from DNS or WINS in the “Printer Name or IP Address” field.

* In the “Port Name” field, the port name is automatically entered according to the IP
address or DNS name entered in the “Printer Name or IP Address” field.

Select “Standard” and click [Next].

Add Standard TCP/IP Printer Port Wizard ﬂ
Additional Port ion Required \L
The device could not be identified. N
=

The detected device is of unknown type. Be surs that
1. The device is prapery configued.
2. The address on the previous page is canect

Either conect the address and perform anather search on the netirk by returming to the
previous wizard page or select the device type if you are sure the addiess is correct

Device Typs

(* Standard |LEEI]

" Custom Settings,

< Back I Nest > I Cancel

26

Installing Network Fax Software
Download from Www.Somanuals.com. All Manuals Search And Download.



When the LPD Print setting is enabled, you can also configure LPR printing. When you want to
configure LPR printing, follow the procedure below.

Select “Custom” and click [Settings].

Add Standard TCP/IP Printer Port

Additional Port Information Required
The device could not be identified.

The detected devics is of unknown typs. B sure that
1. The deviee is properly configured
2. The address on the previous pags is correct

Either carrect ths addiess and periom anather search n the network by raturming to the
previous wizard page or select the device e i you are sure the address is canect.

Device Typs

(" Standard |Generic Network Card =

' Custom Settings

<Bak [ News | Cancdl |

Select “LPR” at the “Protocol” option, enter “Print” in the “Queue Name” field at the
“LPR Settings” option, and then click [OK].

figure Standard TC| Port Monitor 2x]
Port Settings |

Part Name IP_10.10.70.105

Frinter Name or [P Address: |1 0.10.70.105
Protocal

’V  Raw « LFR |
Fiaw Setting:

’VPurl Humber |s1 ] ‘

~LPR Setting

Gueue Name: |an

™" LPR Eyte Counting Enabled

T~ SNMP Status Enabled

Community Mame Ipublic

SHME Device Indes: |1

Cancel

Click [Next].

Add Standard TCP/IP Printer Port

Additional Port Information Required
The device could not be identified.

The detected devics is of unknown typs. B sure that
1. The deviee is properly configured
2. The address on the previous pags is correct

Either carrect ths addiess and periom anather search n the network by raturming to the
previous wizard page or select the device e i you are sure the address is canect.

Device Typs

(" Standard |Generic Network Card =

' Custom Settings

< Back Next > Cancel
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8 Click [Finish].
£

Completing the Add Standard
TCP/IP Printer Port Wizard

‘fou have selected a port with the following characteristics.

SHMP. Mo

Pratocol: Réw, Port 3100
Device: 101070105

Port Mame: IP_1010.70.105
Adapter Type: Generic Metwork Card

To complete this wizard, click Finish.

<Back [ Fnkh | Cancel |

The screen returns to the Printer Ports dialog box.

9 Click [Close] to close the Printer Ports dialog box.

Avallable port types:

Local Port

Mew Port Type... | NEwPurtml cose |

1 0 Make sure the created Raw TCP or LPR port is checked in the “Print
to the following port(s)” list and click [Close].
| TosHizA c STUDIOZ05 Fasroperties 2]

General | Shaing Parts | Advanced | Color Management | Secuiy | About |

=

TOSHIBA e-3TUDIOZ05 Fax

Bint to the fallowing par(s). Documents wil print to the first free
checked part
Port [ Desciiption [ Printer [«
O coMz Serial Port
D coM3: Serial Port
O coms: Serial Patt
CIFILE:  Print toFile
1P 10, Standard TCP/IF Fart

Add Port... Delete Port LConfigure Port...

™ Enable bidiiestional support
™ Enable printer pooling

Cioss | Concel Apply Help
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Uninstalling the Network Fax Driver and Address Book Viewer

The following instructions describe how to uninstall the Network Fax Driver and Address Book
Viewer. The uninstallation procedure is different depending upon how you installed the client
software.
* Uninstallation of the Network Fax Driver and Address Book Viewer

P.29 “When installed using the installer”
¢ Uninstallation of the Network Fax Driver

P.33 “When installed using Add Printer Wizard”

When installed using the installer

When the client software was installed using the Installer in the Client Utilities CD-ROM, you can
delete all files using the Add/Remove Programs function.

You can uninstall all client software that have installed from the Client Utilities CD-ROM, or you
can uninstall only the Network Fax Driver and Address Book Viewer.

P.29 “Uninstalling the all client utilities software”

P.31 “Uninstalling only Network Fax Diver and Address Book Viewer”

Uninstalling the all client utilities software

The following describes an installation on Windows 2000. The procedure is the same when
other versions of Windows are used.

Open “Control Panel” and double-click the “Add/Remove Pro-
grams” icon.

B3 Control Panel (=] 5|
File Edit Wiew Favarites Tools Help ﬁ
dmpack - = - (5] | Qhoearch [yFoiders (B B2 B2 1 = | E-
Adiress [ Control Panel | ¢
= : % -
& Accessibiity  AddiRemove Adrinistrative  Automatic
Control Panel Options Hardware Tools Updates
add/Remove Prograns ([ & Oy
Installs and remaves programs and
‘windows components SR Date/Time Fax Folder Options
windows Lipdate .
windows 2000 Support A‘% :j ;éé,% @
Fonts Game Tnkernet JavaPlugdn  Keyboard
Controllers Options
& g
Mouse Metwork and Phone and  Power Options Printers
Diakup Ca...  Modem ...
® 2 4 &
Regional  Scanners and  Scheduled  Sounds snd Systam
Options Cameras Tasks Multimedia
|
[Installs and remaves programs and Windows components | & My Computer 7
The Add/Remove Programs dialog box appears.
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Download from Www.Somanuals.com. All Manuals Search And

1




Select “TOSHIBA e-STUDIO205 Series Client” and click [Change/
Remove].

Kg; Add /Remove Programs =lolx|
Currently installed programs: Sart by Name -

"l;! TOSHIBA e-STUDIOZ205 Series Client

b inf

Change/Remove

Close
The InstallShield Wizard dialog box appears.

3 Select “Remove” and click [Next].

Toshiba e-STUDID205 Series - InstallShield Wizard 5‘
Welcome! Maintenance Progtam. '

o

“l—.

This program lets you modify the current installation. Click one of the options below.

© Modiy
Selsct new program companents to add or sslect curiently installed
components to remove,

£ Regai
ﬁ Rieinstallall program camponents installed by the previous setup.

' Remove

2 Remove dll installed components

IrstallShield

<Back Net> | Cancel |

The Confirm Uninstall dialog box appears.

4 Click [OK].
Confirmuninstall |

You are going ta completely uninstall all of the Teshiba e-STUDIO20S Series Software Companents.Do you wank to continue?

5 Click [Yes] to delete the setting files.
=

Do you want to delste the settings for the follawing components?
Toshiba e-STUDIO20S Series AddressBookifizwer

Deleting files starts.

If you want to re-install the client software later, click [No] to remain the setting files. You
can restore the data and settings when you re-install the client software.

30 Installing Network Fax Software
Download from Www.Somanuals.com. All Manuals Search And Download.



Select “Yes, | want to restart my computer now.” and click [Finish]

to restart your computer.

Toshiba e-STUDIO205 Series - InstallShield Wizard

InstallShield Wizard Complete

=5 TUDIO205 Series rom your computer,

@ ‘Yes, | want to restart my computer now.

€ Mo, | will restart my computer later.

complete setup

InstallShield Wizard has successfully uninstalled Toshiba

Fiemove any disks from their drives, and then click Finish to

< Bank Finish I

Cenzel |

Some files may be deleted after restarting the computer.

Uninstalling only Network Fax Diver and Address Book Viewer

The following describes an installation on Windows 2000. The procedure is the same when

other versions of Windows are used.

Open “Control Panel” and double-click the “Add/Remove Pro-

grams” icon.

Fle Edt Vew Favortes Took Help ‘ﬁ

-l

=gk - = - (2] | @isearch [Foiders (|5 U X | B

Address [0 Control Panel

~| Pa

Contr;zl Panel

b Accessibiity
Options

AddfRemove
Hardvaare

f il
Add/Remove Programs =] gan C{.
=
Installs and removes programs and ] -
Windows components CShiw Drate/Tirne: Display
Windows Update
Windaws 2000 Support
e o,
Forts Internet
Controllers  Options
D
Mouse  Metworkand  Phone and
Diatup Co...  Modem ...
® 2
Regional  Scanners and  Scheduled
Options Cameras Tasks

Administrative  Automatic

Java Plug-n

Fower Options

|»

B\ W

Tools Updates

&9

Fax  Folder Options

L &=

keyboard

q @

Printers

¢ & -

nstalls and remaves programs and Windows components [

Soundsand  System
Hultimedia -
'S My Computer v

The Add/Remove Programs dialog box appears.
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2 Select “TOSHIBA e-STUDIO205 Series Client” and click [Change/
Remove].

Kg; Add /Remove Programs =lolx|
Currently installed programs: Sort by:[Hame =

"l;! TOSHIBA e-STUDIOZ205 Series Client

Click inforr

Change/Remove

Clgse

The InstallShield Wizard dialog box appears.
3 Select “Modify” and click [Next].

Toshiba e-STUDIDZ205 Ser;

- Installshield wizard

‘Welcome! Maintenance Program.

This program lets you modify the current installation. Click one of the options below.

& o

Selsct new program companents to add or sslect curiently installed
components to remove,

" Fgpair

Reinstall all program components installed by the previous setup.

Remove all installed components.

IrstallShield

< Back Next > I Cancel

4 Uncheck the components that you want to uninstall and click
[Next].

Toshiba e-STUDIDZD5 5S¢ - InstallShield rd 5‘
Add/Remove Tashiba e-STUDID205 Series Components. '

.

Select the components you want to install on your computer. Deselect the companents you
want to remove from yaLr compLiter

Toshiba e-5TUDIO205 Series PCLE Deser

oshiba e-3TUDIO205 Series PSL3 Setup wil install the Toshiba
&STUDID205 Series

AddressBaokliewer on your

computer.

gfa TrueT ppe Fonts

Kl | 2]
36,64 ME of spacs required on the C drive
26526,23 MB of space available on the C diive

Iristal Shicld

< Back Nest > I Cancel

Deleting files starts.
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5 Click [Yes] to delete the setting files.

Toshiba e-STUDIO205 Series X
Do you wartt ko delete the settings for the Following components?
Toshiba e-5TUDIOZOS Series AddressBookiiewer

Deleting files starts.

If you want to re-install the client software later, click [No] to remain the setting files. You
can restore the data and settings when you re-install the client software.

Select “Yes, | want to restart my computer now.” and click [Finish]
to restart your computer.

Toshiba e-STUDIO205 Series - InstallShield Wizard

InstallShield Wizard Complete

Setup has finished updating Toshiba e-STUDIN205 Series on
your computer.

@ “Yes, | want to restart my computer now.

€ Mo, | will restart my computer later

Riemove any disks from their drives, and then click Finish to
complete setup

< Bank Finish I Earice]

When installed using Add Printer Wizard

When only Network Fax Driver is installed by Add Printer Wizard, you can uninstall them by
deleting the printer icons in the Printers folder.

Deleting the Network Fax Driver

1 Open “Printers” folder, select the printer icon that you want to
delete, and press the [Delete] key.

* When using Windows 98/Me or Windows NT 4.0, uninstallation has finished.
¢ When using Windows 2000/XP/Server 2003, continue to the next step.
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2 Click the [File] menu and select [Server Properties].

~loix
Fle Edt View Favorites Tools Help ‘

Qsearch [GFoders (3| 08 W X = | B

Create Shortcut

~| @
Delete

—
Properties =

Add Printer  Acrobat TOSHIBA
lose Distiler  esTUDIL.,

This Folder contains information
abaut printsrs that are currently
installed, and a wizard ko help you
install new printers,

To get information about a printer

that is currently installed, right-click.

the printer's ican. |
-

\CD Displays properties For this server,

The Print Server Properties dialog box appears.

3 Display the Drivers tab. Select the Network Fax Driver and click
[Remove].

& Print Server Properties 2|

Forms | Parts  Diivers | Advanced |

@ T_TAKEDZ

Installed printer diivers

| Enviorment [ Yersion

Add | memove | updste | Properes. |

’D—KI Cancel | Apply |
The confirmation dialog box appears.

4 Click [OK].

Print Server Properties

IS

@ Deleting this printer driver will remove it from the system. Are you sure you want to delete TOSHIBA

£-5TUDIOZ055eries PCLE?
fes i)

The Network Fax Driver is completely deleted.
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FAXING FROM CLIENT COMPUTERS

This section describes the instructions on how to send a fax using the Network Fax Driver.

Faxing from Applications..........ccocriiiiiirrrnrcrrssrrr e
How to fax using the Network FaxX DIiVET ..........cciiiiiiiie e
SPECITYING FECIPIENTS .. ... et e e e e e e e st e e e e s st e e e araeeaean
Setting up the NetWork fax OPLIONS .........veiiiiiee e e
Sending with extended fax FUNCHONAIITY ...........ooiiiiiii e
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Faxing from Applications

The Network Fax Driver allows you to fax document data from your computer to several destina-
tions. It also enables the setup of the fax properties and editing of the sender’s information.

Check if all the fax settings of this equipment have been done prior to fax transmission.

Fax functions using the Network Fax Driver are available only when both the Network Printer
Kit (optional), the Fax Kit (optional) and the External Keyboard (optional) are installed.

How to fax using the Network Fax Driver

Follow the procedure below to fax document data from your computer with the Network Fax
Driver installed.

* Create a document.

¢ Print to Fax Driver.

* Add recipient’s name and fax numbers.

* Select a default cover page (optional).

¢ Send the fax.

The maximum number of pages to fax a document using the Network Fax Driver is 1000.

Preparing documents for faxing

To see how objects, such as headers, footers, or drawing objects, will be positioned on a fax
page, switch to your applications’ page layout view. If the software application you are using pro-
vides a Print Preview option, you can use it to view your fax before it is sent.

Faxing from Windows applications

Once you have installed the Network Fax Driver, you can send the document directly from most
Windows applications as a fax.
You can print using various functions by setting print options on the printer driver.

Faxing from Windows applications

Open afile and select [Print] from the [File] menu of the application.
¢ The Print dialog box appears.
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2 Select “TOSHIBA e-STUDIO205 Series Fax” and Click [Properties].

21x

rPrintet
arne: ¢ Properties
Status: Idle
Type: TOSHIBA e-5TUDIOZ0S Fax
Where: ™ Print to fils
Comment:

Page rangs Copit
o al Mumber of copies: 1 E‘
" Current page  Selection
" Pages 11 ¥ Collate
Enter page numbers and/or page ranges
separated by commas. For example, 1,3,5-12

Print what:  [Document ~| | Pagespersheet: [ page -
Scale to paper size: |Na Scaling -

Cancel

Pint:

)l pages in range -

Opkions. ..

Zoom

The properties dialog box appears.

Tip

The procedures for displaying the properties dialog for the printer driver may be different
depending on the application you are using. See your application’s manual about dis-
playing the printer properties dialog box.

3 Display the Send tab and specify the recipients, and other options.

Send | Cover Shest | Sendr Information | About |

2

To:
Select From Address Book... | Hews... | Fiemoye I
Resolution: [ Sandard (200 % 100 o) v | Dt Coder |
Paper Size: ILetler j Orientation: IPurtla\t j

0K | Cancel | Hep

P.39 “Specifying recipients”
P.49 “Setting the send properties”
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Display the Cover Sheet tab and specify the cover sheet properties
if you want to send a document with a fax cover sheet.

&% TOSHIBA e-STUDIOZ05 Fax Properties x|

Send  Cover Shest | Sender Information | About |

Cover Sheet: Standard Cover Page

Fark Name: [ Times Mew Roman = |

Subject I

Meszage ;I

™ Sender Information

I Recipients Information
™| Hame ™ Compary
I” Department Mame: I FanNumber

™ Reference Number:

0K | Cancel | Hem |
P.51 “Setting up the cover sheet properties”

5 If you want to add sender information on a fax cover sheet, check
the Sender Information check box. Then click the Sender Informa-
tion tab and then enter the sender information message you want to
add on the fax cover sheet.

%" TOSHIBA e-STUDIOZ05 Fax Properties d B3

Send | CoverSheet Sender Information |About|

Fill cut the information you want to appear on your fax cover shest

0K | Cancel | Hem |

P.52 “Setting up the sender information properties”
6 Click [OK] to save the settings.

7 Click [OK] or [Print] to send a document.
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Specifying recipients

You can specify the recipients following method:
P.39 “Specifying recipients from address book”
P.43 “Entering a recipient manually”

Also you can remove the recipients added to the “To” list.

P.44 “Removing recipients from the “To” list”

Tip

You can specify up to 100 recipients.

Specifying recipients from address book

1 Click [Select From Address Book] in the Send tab.

Send | Cover Shest | Sendr Information | About |
To:
Select From Address Book... | Mew... | Remaye I
Reslution, |standard (200 100 dpij) | Dept Coder [
Paper Size: ILetIer d Orientation: IPD”'“‘[ d
0K | Cacel | Hep

The Address Book Viewer is launched.

To utilize the address book, you must register contact information into the address book
in advance. For this registration, see the following page:

P.58 “Running Address Book Viewer”
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2 Select either Group or Location/People in the desired address
book.

Eif e-5TUDIO AddressBook Yiewer x|
File Edt WView Tools Help

BE BBRE X AR B EE

SHIBA Address Book Display Name: | Fax Number | Email Address -
Private Address Book (= User Userdl 0000000001 LserD @ifas.com
B = ser Lser2 nnnnnnnnnnz LsD2@ita som
B User Userl3 0000000003 LserD3@ifas.com
B ser Lser nnnnnnnnnng s 4@t com
MEPI Address Baok B User Useds 00000000005 Lse05@itar.com
MS Duthok: Address Book B User Usels 00000000006 userDB@itar com
:';A; ’2‘;‘;’:3 gz::;\ B User Usert? 00000000007 userD7 @iar com
B = ser Lser nnnnnnnnnng s 0Bt Som
B User Userld 00000000003 LserD3@ifar com
S User Lserin nnnnnnnnm o s Dt som
B User Userl1 00000000011 user! 1 @ifas.com
B ser Lser12 nnnnnnnnm 2 s 2@t som
B User Userl3 00000000013 User] 3@ifas.com
B ser Lser1 4 nnnnnnnnm 4 s @it com
B User Userls 0000000015 Lser] 5@ifas.com
B ser LserlB nnnnnnnnm s Bt som
B User Userl 7 000000001 7 werl@ifancom
B ser Lser18 nnnnnnnnm & s Bt com
00000000013 User] 9@ifas.com
B NNNNNNNNM21 L INf@i Y r =
fi il

[ [The total number of the contacts: 22/2000

Private Address Book — This contains the contacts registered in the associated client
address book on your client computer.

Public Address Book — This contains the contacts registered in the address book in
this equipment.

MAPI Address Book — This contains the contacts in the address book of the default
mail client in your computer.

MS Outlook Express — This contains the contacts in the MS Outlook Express address
book in your client computer.

LDAP Address Book — This contains the contacts in the specified LDAP server.
Import Address Book — If the address book data have been imported from a CSV file
or vCard file, this address book will be displayed.

Tip

For more information about the Address Book Viewer, please refer to the Address Book
Viewer Online Help.

40 Faxing from Applications

Download from Www.Somanuals.com. All Manuals Search And Download.



Select the contact you want to add as a recipient and click the [Fax]

icon (@) in the tool bar.

Eifl e-STUDID AddressBook Yiewer x|
File Edit View Tools Help
@éxlﬁﬁ?lﬁéz

=-Ef TOSHIBA Address Book Display Name [ Fax Number [ Email Address -
EH-HH Private Address Book S ser UserT] 00000000001 useil1@ifar. com
G Group B User Lserl? 00000000002 usei02@ian com
i Lacstion/Psopls B User Usein3 00000000003 user03@iax com
B Public Address Book B Liser seis 00000000004 wsei4@ifan com
EER MAPI Address Boak B User Useits 00000D00N0S LseDB@an com
{28 MS Oullok Address Bock B User Lseil 0000000006 LserlEG@itan com
S ‘LmDDA;’::‘;zz 2izt B User Useid? 00000000007 useiD7@iax com
B User Userda 00000000008 usei0B@iaH com
B User Userda 00000000009 usei0SGia com
B User Userl0 00000000010 user] OGias, com
B User Userl1 00000000011 userl 1@ias com
B User Lserl 2 00000000012 userl 2G@itan com
EUser Userl 3 00000000013 userl 3@ita com
EUser Userl 4 00000000014 userl 4(@ita com
= User Userls 00000000015 user SGifa com
=3 User Userl& 00000000016 user] 6@ias, com

= User Userl 7 00000000017 wel T@ilaneom
= User Userl 00000000013 userl SG@itan com
B User Lserla 00000000013 user S@ita com

q =11 Hemr | el NONNONNAN0 1ear ANk Ay mnmn I Ll;l
[ [The tatal number of the contacts: 22/z000

* Repeat until all required recipients are selected.
* When you select the fax number as a destination, the fax number icon in front of the

name of the contact will be changed to the checked fax icon (@ )-

* You can cancel selecting the fax number by selecting the contact and re-clicking the
[Fax] icon in the tool bar.

* You can also select the recipient’s fax number by right-click the contact and select
[Select] and [Fax Number] in the menu displayed.

After you selected all recipients, right-click on a recipient name in
the right pane and select [Selection] in the menu displayed.

Eif e-STUDIO AddressBook Yiewer x|
File Edit Views Tools Help
2 BRE X AR B EE
= 8 TDSHIBA Addhess Book Fas Number Emai Address

Private Address Book £ = 00000000001 user01 @ifax.com
2 Group BRI " ooz L2 @itas com
Location/People B P 00000000003 useiD3@itar com
Public Address Bank Bl 00000000004 LserDdi@itas com
MAP| Addess Book Buss  roPoties 00000000005 user5@itar com
[‘;;“}i\'s;::::g':;i Book BEUs ;’::: , | oonoooooos LseiDB@itar.com
oot e Bosk BEuse n00DROONN? e —
00000000003 LseiDB@itar.com
B User Userna n00DROONNS st com
B User Userld 0000000010 user| D@itak.com
B User zer11 000DROONNT1 s 1 @it com
B User User12 00000000012 Lser] 2@itar.com
B User Usena n00DD0ONT3 s It com
B User Userl4 00000000014 Lser 4@itar.com
B User Usens n00DDOONTS s @it com
B User Userl6 00000000016 user|B@itar.com

B User Usen? n00DROONNT 7 e e
B User Userls 00000000013 Lser| B@itar.com
B User Usera n00DDOONTS s 9@t com

ﬁ':‘ aer sepr NN nser 2N A ~om I —"LI
|confirm Selection [The tatal number of the contacts: 222000

The Destinations dialog box appears.

Tip
You can also display the Destinations dialog box by clicking the [Selection] icon (ﬂ) in
the tool bar.

Faxing from Applications 41

Download from Www.Somanuals.com. All Manuals Search And Download.



Confirm the destinations that you select in the dialog box. If you
wish to remove a destination from the recipients list, select the con-
tact and click [Remove].

ﬂ
Confitm selected contacts. To remove a contact, select the contact hen sslect the Remove icon
Display Narne: [ 07D [ Group Mame | Fax Number Email Address
7B User Userls 00000000005 wser5i@ifax.com
B UserUsed 00000000004 wser4@itax com
B UserUsed3 00000000003 wserli3@ifax.com
B UserUse2 00000000002 wser2@itax com
TR User Usert 00000000001 wserdl @ifax.com
gl 1>
Aemoe | 0K | Cameel | Help |

In the Destinations dialog box, the following buttons are available:

* [Remove] — Click this to remove the selected contacts from the destinations list.
¢ [OK] — Click this to add these contacts as the destinations.

* [Cancel] — Click this to cancel the selection.

¢ [Help] — Click this to display the online Help.

6 After you confirm the destinations, click [OK].
20

Send | Cover Shest | Sendr Information | About |

Tox [1ser User1 (00000000001]
User User(2 (00000000002)
User User03 [00000000003]
User User(4 (00000000004)
User User05 [00000000005)

Select From Address Book... I Hews... | Fiemoye I
Resolution: [ Sandard (200 % 100 o) v | Dt Coder |
Paper Size: ILetler j Orientation: IPurtla\t j
0k | Cacel | Hep |

¢ The Address Book Viewer is closed and selected recipients are added to the “To” list.
* If you click [Select From Address Book], you can add the recipient to the “To” list in
this screen by searching the address book for it. There are two searching methods;
searching for contacts by name or fax number and searching for contacts by detailed
search conditions. See the following.
P.44 “Searching the address book for contacts”
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Entering a recipient manually

1 Click [New].

Send | Cover Sheat | Sender Information | About |
Tor
Select From Address Book... | Hews... | Fiemoye I
Resohion  [Siangard (200 100 o) 7] Dopt Code: |
Paper Size: ILetler j Orientation: IPortla\t j
0K | Cancel | Hep

The Direct Dial dialog box appears.

Enter the fax number in the right field. In addition, if you specify a
Sub address, enter the Sub address in the “SUB” field, and security
password for the Sub address in the “PWD” field if required.

B
Fax Mumber [

SUB. I FPwD I

Cancal I

Tip

If you specify a Sub address complying with ITU-T F-code communications, you can for-
ward fax data to any fax machine regardless of its manufacturer or the model. In this
case, however, the recipient’s fax machine also must support ITU-T F-code functions.

Click [OK].

Entered recipient is added to the “To” list.
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Removing recipients from the “To” list

1 Select a recipient that you want to delete from the “To” list.

&” TOSHIBA e-STUDIOZ205 Fax Properties 2]

Send | Cover Shest | Sender Infomation | About |

User User05 (00000000005]
[ERRRRRARRANI]

Select From Address Back .| New. | Remave |

Resolion:  [Siandard (200 £ 100 ) ] Dept Cace: |

Paper Size: [Cetter ] Orientation:  [Popai |

oK I Cancel Help

2 Click [Remove].

The selected recipient is deleted from the “To” list.

Searching the address book for contacts

In order to quickly locate contacts you can search the address book database. You simply type
in a string or letters to be used to search the database. The Address Book Viewer will search for

any entry that contains the specified string.

You can search contacts by the name and fax number. Also you can search contacts by specify-

ing the detailed search conditions.

Searching contacts by name and fax number

1 Click the [Edit] menu and select [Find].

Eifl e-5TUDID AddressBook Yiewer
File | Edit View Tools Help

Copy  ChitC
2| paste iy

Select Al Chrl+A

Display Name [ Fax Number [ Email Address

MAP| Addiess Book
M3 Dutlook Addiess Book
LDAP Addiess Book
Import Address Book

[Search for contacts Jojo

The Find Contact dialog box appears.
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Select an address book to search contacts in the “Data Source”
drop down box.

Find Contact

DataSource:  |Public Addhess Book |
ddress Book
ook

Person | Detai 54

ok,
M5 Outlook Address Book

Harme Idap toshiba.com

Fan Mumber:

Fhd il I

Tip
The default address book in the “Data Source” can be set by selecting [View] - [Default
Configuration] - [Data Source] from the menu bar.

Display the Person tab and enter search text in the following fields
that you require.

I
DetaSource: | Public Address Baok =l
Persan | Detail Setting |
Display Name: ~|user
Fa Number: [
E-Mait [
Seach

cer|

Giroup Name | Display Hame | Fa Mumber Email Addiess

< | i

addiess | Cearal | | Cose | Hep |

Name — Enter the search characters or string to search by the first name.

Fax Number — Enter the search characters or string to search by the contact fax
number.

E-Mail — Enter the search characters or string to search by the contact e-mail address.
(E-mail reception is not available in the equipment.)

You must enter one of the field to search contacts. It will search the contacts that have
exactly same name or fax number as the entered search strings.

Tip
If you want to clear entered values, click [Clear All].

Click [Search].
It begins searching contacts in the selected address book. When it completes searching,
found contacts appear in the list at the bottom of the dialog box.

Tip

If you want to stop searching, click [Stop].
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Searching contacts by detailed search conditions

1 Click the [Edit] menu and select [Find].

Eif e-STUDIO AddressBook Yiewer x|
File | Edit View Tooks Help
Copyl  ChitC
2| P apy X BB & E =
5 SelectAll cirlia Display Hame [ Fa Mumber | Email Addiess |
ok
MAP Address Book
MS Outlock Addiess Book
LDAP Address Book
Import Address Book
[Search For contacts loja

The Find Contact dialog box appears.

Select an address book to search contacts in the “Data Source”
drop down box.

D ata Source: I j
Frivate Address Book,
Person | PEETRE: P blic &ddress Book
MAP| Address Bool
M5 Outlook Address Book
Idap.tashiba. com

M ame:

Fax Murnber:

C hd =il I
Tip

The default address book in the “Data Source” can be set by selecting [View] - [Default
Configuration] - [Data Source] from the menu bar.

3 Display the Detail Setting tab and select a field to search in the
“Field Select” drop down box.

Find Contact x|
Data Source: IF'uinc Address Book j

Perzon  Detail Setting |

Define Condition:

Field Select: Condition of zearch string:
IDispIay Mame j IEontains j |

Fax Mumber
Ernail Address Add

First Mame B z
Delete | LI

L |
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Select how it searches contacts in the “Condition of search string”
drop down box.

Field Select: Condition of search string:

IDispIay Mame j IEontains j I

Condition list:

sl

Delete | ﬂl
Chmr I
Contains — Select this to search contacts that contain the search string.
Is — Select this to search contacts that completely match the search string.
Start with — Select this to search contacts that start with the search string.
End with — Select this to search contacts that end with the search string.

Enter the search string in the next field to the “Condition of search
string” drop down box.

Field Select: Condition of search string:
IDispIay Mame j IEontains j Iuseri
Condition list:

Add

Delete | ﬂl

el

Click [Add].

Specified search condition is added to the condition list.
Tip

If you want to clear entered values, click [Clear All].

Repeat the procedure from Step 3 to Step 6 to add all required con-
ditions.

Field Select: Condition of search string:
IDispIay Mame j IEontains j Iuser
Condition list:
Dizplay Mame Contains user Add
Delete | ﬂl
Cham I
Tip

You can remove the search conditions you have added. To do this, select the condition
and click [Delete].
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8 Click [Search].

I
DetaSource: | Public Address Baok =l
[m— DetallSeltlngl
Define Condition
Field Select Condition of ssarch sting:
[Dicplay Name | [contains =
Condition list:
Display Mame Containg user dd
| =
cer|
Giroup Name | Display Hame | Fa Mumber Email Addiess -
User Userd1 00000000001 wse01 @ifak.com
User Userd2 0000000002 wserZGifar.com
User User03 00000000003 wser03@ifak.com
User Userd4 Q0000000004 wser4Gifar.com
User User05 usel5@itar com =
Addiess || ClearAl | aaa | Cose | Hep |

It begins searching contacts in the selected address book. When it completes searching,
found contacts appear in the list at the bottom of the dialog box.

Tip
If you want to stop searching, click [Stop].

9 Select the searched contacts and click [Address].
=

DataSource: | Public Addhess Book |

Persan  Detai Setiing |

Define Condition,

Field Select: Condition of search sting:
Digplay Name [~ Containg 2
Condition list:
Diisplay Name Containg user Add
v || || =T
Siop |

Graup Name Display Wame Far Number Email Address

Addess | Cearal | | Cose | Hep |

The Type Selection dialog box appears.

1 0 Be sure that the “Fax Number” check box is checked and click
[OK].
]

Select Destination Type:

I~ | Email Address

IV Fax Number

o | Concel |

The Destinations dialog box appears.
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11 Click [OK].

5|
Confiim selected contacts. To remove a contact, select the contact then select the Femove ivon.
Display Mame [ 070 [ GroupMame [ FaxMumber | Email Address
TR Lser sl 00000000005 wser5@ifan com
TR User Userd Q0000000004 wserMi@ifax com
B UserUsera 00000000003 wser3@ifan com
B User Userl2 Q0000000002 wserl2i@ifax com
B UserUsen 00000000001 wserl @ifax com
< 3|
femeve | [i3 ] Cancel | Hep |

The selected contacts are added as recipients for the network fax.
2%

Send | Cover Shest | Sender Infomation | Aot |

T [Ter Userll (QO00000000T

User User0d (0000000005

Select From Addisss Book... | New. | Aemove |
Resobdion. [Standard (200 100 4o __x] Dept Code: |
PaperSis  [Loter B T ——

aK I Cancel Help

Setting up the network fax options
Network fax options are the attributes you set to define the way a fax job is transmitted. For
example, you can specify the recipients, resolution, and paper size.
Tip
You can send a fax with a cover sheet. See the following for details.
P.53 “Sending with extended fax functionality”

Setting the send properties
In the Send tab of the network fax properties dialog box, you can specify the recipients and how
the fax will be sent.

Tip
To specify the recipients, you can select from the address book or enter the recipient manually.
P.39 “Specifying recipients”
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%" TOSHIBA e-STUDIDZ05 Fax Properties 2xl

Send | Cover Sheetl Sender Infnrmatinnl About I

Tar

3
2 ————————  Select From Address Book... | Mew... | Fiemowve 4
5 ——————Resolution: ISlandard [200 % 100 dpil vl Dept. Code: I 6
7 ————————Paper Size: ILetter vl Orientation: | porait =t 8

ak I Cancel Help

1) To
This displays the specified recipients list.

2) [Select From Address Book]
Click to launch the address book Viewer. You can select recipients from the address book.
P.39 “Specifying recipients from address book”

3) [New]
Click to add new recipient by entering manually. The Direct Dial dialog box appears.
) P.43 “Entering a recipient manually”

4) [Remove]
Select a recipient in the “To” list and click this to remove the recipient from the list.

5) Resolution
Select the resolution for the fax.
- Standard (200 x 100 dpi) — Select this to send a document in Standard mode (200 x
100 dpi).
- Fine (200 x 200 dpi) — Select this to send a document in Fine mode (200 x 200 dpi).
- Super Fine (200 x 400 dpi) — Select this to send a document in Super Fine mode (200
x 400 dpi).
- Ultra Fine (400 x 400 dpi) — Select this to send a document in Ultra Fine mode (400 x
400 dpi).
6) Dept. Code

Enter 5-digit department code if required. When the department code is enabled on this
equipment, you must enter the department code to send a fax.

How this equipment performs fax transmission for an invalid department code fax job differs
depending on the configurations of this equipment. When it is set to delete a job with an
invalid code (= the equipment’s default setting), the job is deleted. When it is set to transmit
an invalid department code job forcibly, the job is transmitted forcibly.
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7)

8)

Paper Size
Select the paper size of your document.

Orientation
Select the orientation of your document.

Setting up the cover sheet properties

In the Cover Sheet tab of the network fax properties dialog box, you can specify the fax cover
sheet to be sent. If you enable the cover sheet, the cover sheet is attached in the first page of
the document and sent to the recipients.

7 ———————————————1 Reference Mumber: I

1)

2)

3)

4)

5)

6)

('*' TOSHIBA e-STUDID205 Fax Properties i ﬂll

Send  Cover Shest |Sender Informationl About |

Caver Sheet IStandard Cover Page j
Fort Name: ITimes Hew Roman j
Subject: I
Message: d
[
v Sender Infarmation
¥ Recipients Information
[~ Name [~ Company
[~ Department Name [~ FauNurnber

0K I Cancel | Help

Cover Sheet

Select the cover sheet type from “Standard Cover Page”, “Business Cover Page”, and “Pro-
fessional Cover Page”. For cover sheet samples, see the following page:

P.112 “Cover Sheet Samples”

Font Name
Select the font to be used for the cover sheet.

Subject
Enter the subject to appear on the cover sheet. You can enter up to 40 characters.

Message
Enter the message to appear on the cover sheet. You can enter up to 500 characters.

Sender Information

Check this to print sender information on the cover sheet. When this is enabled, specify the
sender information in the Sender Information tab.

P.52 “Setting up the sender information properties”

Recipient Information

Check this to have recipient information appear on the cover sheet. Select one or more of
the following options to determine what information will appear in the “To:” field of the cover
sheet.

- Name — Check this to have the recipient name appear on the cover sheet.

- Company — Check this to have the recipient company name appear on the cover sheet.
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- Department Name — Check this to have the recipient department name appear on the
cover sheet.

- Fax Number — Check this to have the recipient fax number appear on the cover sheet.

7) Reference Number
Enter the reference number to identify the fax. This number will appear on the cover sheet.

Setting up the sender information properties

In the Sender Information tab of the network fax properties dialog box, you can specify the
sender information that appears on the cover sheet. This must be set only when the “Sender
Information” box in the Cover Sheet tab is checked.

In the text field in the Sender Information tab, you can enter the up to 500 characters.

%" TOSHIBA e-STUDIOZ05 Fax Properties A |

Send | CoverShest Sender Information |About |

Fill out the information you want to appear on your fax cover sheet

QK I Cancel Help
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Displaying the version information

In the About tab of the network fax properties dialog box, you can display the version information
of the Network Fax Driver.

%" TOSHIBA e-STUDIOZ0S Series Fax Properties A |

Generall Sharingl Ports I Advancedl EolorManagementI Security

TOSHIBA

=stupio205 series
N/W-Fax Driver

Wersion 282610
Localize Yersion  015.000

Copyright (] 2004,2006 TOSHIBA TEC CORPORATION All Rights Reserved.
Copyright [c] 1998 - 2005 Monotype Imaging Inc. All Rights Reserved.
Copyright [c] Hewlett-Packard Company Al Rights Reserved.

QK. I Cancel Lpply Help

Sending with extended fax functionality

The Network Fax Driver allows users to perform the following features:
P.53 “Sending with a cover sheet”

Sending with a cover sheet

You can choose to send a cover sheet with your fax transmission. The cover sheet is merged
with the recipient “To” list data to create a fax cover sheet. You can select what to include on the
cover sheet such as sender or recipient information.

Preparing the cover sheet

1 Display the Cover Sheet tab and select the cover sheet type in the
“Cover Sheet” drop down box.

&% TOSHIBA e-5TUDIO3511-4511 FAX Proper 21x|

Send  Cover Sheet | Sender Informationl About I

Caver Sheet: I Mone j

Fart I ame: Standard Cover Page

Professional Cover Page

Subject:

For samples of the cover sheets, see the Appendix at the end of this guide.
3 P.112 “Cover Sheet Samples”
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Select the font in the “Font Name” drop down box.

Font Name: ITimes Mew Roman ﬂ
I arlett -
Subject:
Arial CE
Arial CYR
Message: Avial Greek -~ l
Arial TUR 4

The selected font applies to the text contents in the cover sheet.

Enter the subject to appear on the cover sheet in the “Subject”
field.

Fant Mame: IA[ial j
Subiject: IFax docurment
Message: ;I

You can enter up to 40 characters for the subject.

Enter the message to appear on the cover sheet in the “Message”
field.

Message: Enter the meszage here. ;I

[~
You can enter up to 500 characters for the message.

If you want the sender information to appear on the cover sheet,
check the “Sender Information” box.

| =

V' Sender Infarmation

™ Rariniante Infarmakion

If you check this, click the Sender Information tab and enter the sender information in the
text box. You can enter up to 500 characters in the sender information text box.

&% TOSHIBA e-STUDIO Series Fax Properties 2=l

Send | CoverShest Sender Information |About |

Fill out the information you want to appear on your fax cover sheet

Uszerd1 ;I

Deptdl Manager
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6 If you want the recipients information to appear on the cover sheet,
check the “Recipients Information” box and check the items
required for the recipient information.

V¥ Recipients Infarmation
v Name V' Company

V¥ Department Name V¥ Fax Mumber

Name — Check this to have the name of the recipient appear on the cover sheet.
Company — Check this to have the company name of the recipient appear on the cover
sheet.

Department Name — Check this to have the department name of the recipient appear
on the cover sheet.

Fax Number — Check this to have the fax number of the recipient appear on the cover
sheet.

¢ Recipients information is obtained from the address book. (The data input on page 3
P.71 “Configuring the connection manually and obtaining the address book data” are
used.) If the recipient is added manually, this information does not appear on the
cover sheet except for the fax number.

* The recipients information for all recipients will appear on the cover sheet.

7 If you want the reference number to identify the document to
appear on the cover sheet, check the “Reference Number” box and
enter the reference number in the field.

I LERIUIETIL N I T e

¥ Feference Mumber IDDDDDm

K I Taneal I Haln I
You can enter up to 20 characters for the reference number.

8 Specify the other options to send a document and click [OK].

9 Click [Print] to send a document to this equipment.
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3 FAXING FROM CLIENT COMPUTERS
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USING ADDRESS BOOK

This section describes the instructions on how to use the Address Book Viewer.

Running Address Book VIEWET .........cccoiiiiiiniinninnnninnnsssssnnnns 58
Running the Address BOOK VIBWET ............eiiiiiiiiiiee et e e e e e e 59
About Address BooK VIeWer iNterface. .........cocuiiiiiiiiiiiiii et 62
L 1S3 1 To T o7 o1 1 4= T To £ PSERR 63

Managing Address BOOK...........coicciiiirrrrecs s e 67
ADbOUL the address DOOKS .........ccviiiiiiee e e 67
Managing CONtaCtS ANd GrOUPS ........eeeiiiiiiiiiii ittt sttt et e e st e e s e e sae e ente e e saneas 86
Converting the address book data ............oueiiiiiiiiic 104
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Running Address Book Viewer

The Address Book Viewer allows you to manage the address book properties, manage address
books and address book entries. Particularly, you can perform the following functions:
Managing the private address book:

* Create new contacts

* Create address book groups

* Modify contact information

* Search the address book database

¢ Import address book data

¢ Export address book data

58 Running Address Book Viewer
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Running the Address Book Viewer

You can access the Address Book Viewer using two methods:
* Programs folder in the Start menu
* Print Properties window of the Network Fax Driver (limited accessibility)

Access using program group

From the Program Group, you can access the Address Book Viewer to create and edit your pri-
vate address book.

Accessing the Address Book Viewer from the programs group

Click the [Start] menu, select [Programs], [TOSHIBA e-STUDIO205
Series], and select [TOSHIBA e-STUDIO205 AddressBookViewer].

% Set Program Access and Defaults

Windows Update
HMew Office Document

Open Office Document

b @ Accessories
Microsoft Access

[dstart [ 1l & 1

The Address Book Viewer window appears.

Eif| e-STUDIO AddressBook Yiewer — o x|
File Edt Wew Took Help

B2 B2 PE xR EE s

B 105HE ok Display Hame [ Fa Mumber | Email Addiess |
=) ok
] Public Address Book
-Ef MAPI Addiess Book
BB MS Outlook Address Baok
BB LDAP Address Book
-EH Import Address Book

loja
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Access using print properties

Within the application Print window, you have a limited ability to create and edit contacts in the

Address Book.

This method is only suggested if you are in the process of sending a fax and you need to add a
fax recipient to the send list that is not currently a member of the Address Book. Otherwise, use
the program group to access the Address Book Viewer.

Accessing the Address Book Viewer from the print properties

1 In the Print dialog box in the application, select “TOSHIBA e-
STUDIO205 Series Fax” for the printer and click [Properties].

 Prirter

21|

M ame:

TOSHIBA e-STUDID Ser

Statusz:
Type:
where:

Caomment:

Feady

IF_10.10.70.83

TOSHIBA e-STUDIO Series Fax

Froperties... |

r— Print range

o Al

€ FPages  from: I bz I

= Selection

Copie:

Mumber of copies:

Iﬂl Iﬂl ¥ | Collate

=1

Cancel |

The Network Fax properties dialog box appears.

2 Click [Select From Address Book] in the Send tab.

%" TOSHIBA e-STUDIO Series Fax Properties 2=l
Fend | Cover Sheet I Sender Information I About I
To
Select From Address Book | Mew | Remove |
Fiesolution: IStandard (200 100 dpi) vl Dept. Code: I
Faper Size: ILetter vl Orientation: IPortrait vl
—Save as File
™ Save as File File: Farmat: ITIFF vl
— Delayed Fa
| Send Fax Now | [er7sz003 438N Ed... |
QK I Cancel | Help |

The Address Book Viewer window appears.
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— Selecting contacts for network fax

When you access the Address Book Viewer from the Network Fax Driver, it allows you to select
the contacts from the Address Book Viewer.

After you select contacts that you want to add as recipients, right-click on a recipient name in the
right pane and select [Selection] in the context sensitive menu.

* You can also select the recipients by searching the contacts in the Address Book Viewer.
* For detailed description on selecting contacts for Network Fax, refer to the following page:
P.36 “Faxing from Applications”

x
Confirm selected contacts. To remove a contact, select the contact then select
the Remove icon.
Dizplay Mame | aTiD | Group Mame | Fax Mumber | Email Address
ﬁ' User Uger05 5 00000000005 userD5(Eifax com
EBEE User UserDd 4 00000000004 user04(@ifax.com
FBEE User UserD3 3 00000000003 userd3@ifax.com
EBEE User User2 2 00000000002 user2@ifax.com
FBEE User User1 1 00000000001 user @ifax.com
1] |»
Femove | QK I Cancel Help |

Then the Destinations dialog box appears.
* [Remove] — Click this to remove the selected contacts from the destinations list.
¢ [OK] — Click this to add these contacts as the destinations.
e [Cancel] — Click this to cancel the selection.
* [Help] — Click this to display the online Help.
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About Address Book Viewer interface

The Address Book Viewer main window consists of the following items:

Eifl e-5TUDID AddressBook Yiewer =101 x|
1 File Edit View Tools Help
»—{Ferer arRe e~
B ¢ ok, Display Narne | Fax Mumber | Email Address |
Private Address Book
Public: Addiess Book
M&P! Address Book
M5 Outlook Address Book
LDAP Address Book
Import Address Book
4
5—— o
1) Menu Bar

You can perform various functions by selecting a command from the menus.
P.63 “Menu bar”

2) Toolbar
You can perform general functions quickly by clicking an icon in the tool bar.
P.65 “Toolbar”

3) Browse Pane

The address books below are displayed in a tree form in the browse pane. Using the browse

pane, you can display the contents of each group or recipient registered in the address

books in the contents pane. (When you click [+] of the tree, the items (group and place / per-

son) of the selected address book appear and the [+] turns into [-]. When you click [-] of the

tree, the items of selected address book hide.)

- Private Address Book — This contains the contacts registered in the associated client
address book on your client computer.

- Public Address Book — This contains the contacts registered in the address book in
this equipment.

- MAPI Address Book — This contains the contacts in the address book of default mail
client in your computer.

- MS Outlook Express — This contains the contacts in the MS Outlook Express address
book in your client computer.

- LDAP Address Book — This contains the contacts in specified LDAP server.

- Import Address Book — If the address book data have been imported from a CSV file
or vCard file, this address book will be displayed.

4) Contents Pane
The right-hand pane displays non-modifiable, text-only summary information about the cur-
rently selected address book entry. Selecting an entry in the browse pane of the address
book displays summary information about the entry in the contents pane.
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5) Status Bar
This displays the description of selected command in the left side, and the number of the
items of the currently selected address book entry in the right side.

Using commands

Address Book Viewer allows you to perform a wide variety of functions.

You can access all of the commands from menus in the menu bar and from the icons in the tool
bar at the top of the Address Book Viewer window. You can also choose commands from con-
text-sensitive menus by right-clicking the browse pane and contents pane.

Menu bar

The menu bar contains five menus of commands that allow you to perform various functions in
Address Book Viewer.

1) File menu
The following commands can be selected in the File menu.

- New Contact — Select this to add new contact in the private address book. If the cur-
rently selected item is a group, the contact will be created as a member of the group. If
the currently selected item is the “Location/People” folder or “Private Address Book”
object, the contact will be created in the "Location/People" folder. This command is avail-
able only when selecting items in the object in the private address book.

- New Group — Select this to add new group in the private address book. This command
is available only when selecting the “Group” folder in the private address book.

- Properties — Select this to edit or display the properties of a group or a contact in the
private or public address book. This command is available only when selecting a group
or a contact in the private or public address book.

- Delete — Select this to delete a group or contacts in the private address book. This com-
mand is available only when selecting a group or contacts in the private address book.

- Devices — Select this to download the public address book from this equipment.

- Import -CSV File — Select this to import the address book data that had been exported
as CSYV files from this equipment, e-STUDIO3510c Series, e-STUDIO451¢ Series, e-
STUDIO850 Series, e-STUDIO452 Series, e-STUDIO282 Series, e-STUDIO4511
Series, e-STUDIO450 Series, e-STUDIO280 Series, GL-1010 address book using the
Address Book Viewer. The data will be imported in the “Import Address Book”.

- Import -vCard File — Select this to import the address book data that had been
exported as vCard files from this equipment, e-STUDIO3510c Series, e-STUDIO451¢c
Series, e-STUDIO850 Series, e-STUDIO452 Series, e-STUDIO282 Series, e-
STUDIO4511 Series, e-STUDIO450 Series, e-STUDIO280 Series, GL-1010 address
book using the Address Book Viewer. The data will be imported in the “Import Address
Book”. This command is available only when Microsoft Office XP is installed on your
computer.

- Export - CSV File — Select this to export the selected address book as a CSV file.

- Export - vCard File — Select this to export the selected address book as a vCard file.
This command is available only when Microsoft Office XP is installed on your computer.

- Exit — Select this to exit the Address Book Viewer.

2) Edit menu
The following commands can be selected in the Edit menu.
- Copy — Select this to copy the selected contacts or a group in the clipboard. The con-
tacts or a group copied in the clipboard can be pasted in the private address book. This
item is available only when selecting a group or contacts in any address book.
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Paste — Select this to paste the contacts or a group copied in the clipboard in the private
address book. If the group has been copied, this item is available only when selecting the
“Group” folder. If the contacts have been copied, this item is available only when select-
ing a group or the “Location/People” folder in the private address book.

Select All — Select this to select all contacts displayed in the right pane. This item is
available only when browsing groups or contacts.

Find — Select this to find a contact by searching the address book. You can also search
the LDAP server to add the contacts in the LDAP address book.

3) View menu
The following commands can be selected in the View menu.

Toolbar — Select this to display or hide the toolbar. When the check mark appears in the
menu, the toolbar is currently displayed. You can select it again to hide the toolbar.
Status Bar — Select this to display or hide the status bar. When the check mark appears
in the menu, the status bar is currently displayed. You can select it again to hide the sta-
tus bar.

Large Icons — Select this to display the contacts using large icons.

Small Icons — Select this to display the contacts using small icons.

List — Select this to display the contacts in a list.

Details — Select this to display the contacts in a list with detailed information.

Sort By - Name — Select this to sort the contacts alphabetically by the name.

Sort By - Fax Number — Select this to sort the contacts alphabetically by the fax num-
ber.

Sort By - Email Address — Select this to sort the contacts alphabetically by the e-mail
address.

Sort By - Ascending — Select this to sort the contacts alphabetically in ascending order.
Sort By - Descending — Select this to sort the contacts alphabetically in descending
order.

Default Configuration - Data Source — Select the address book that will be the default
address book for the Find Contact dialog box. Select the address book from which you
frequently search for the contacts. The public address book is set as the factory default.
Default Configuration - Type Selection — Select the default destination type that will
be enabled in the Type Selection dialog box, which appears when searching for the con-
tacts as the destinations of the network fax job. You can select either “Fax Number”,
“Email Address” or “Both” to set the default selection type. The “Fax Number” is set as
the factory default. This can be set only when the Address Book Viewer is launched from
the Network Fax Driver.

4) Tools menu
The following commands can be selected in the Tools menu.

LDAP Setting — Select this to configure the LDAP service to obtain the LDAP address
book from the LDAP server.

Device Setting — Select this to find the device to obtain the public address book from
this equipment.

Converting — Select this to run the Address Book Converter. Using the Address Book
Converter, the address book file of the GL-1010 or GL-1020 that can be created using
TopAccess can be converted to the address book file that can be restored or imported to
this equipment, e-STUDIO3510c¢ Series, e-STUDIO451¢ Series, e-STUDIO850 Series,
e-STUDIO452 Series, e-STUDIO282 Series, e-STUDIO4511 Series, e-STUDIO450
Series, and e-STUDIO280 Series with TopAccess. This command is available only for
Windows NT 4.0, Windows 2000, Windows XP, and Windows Server 2003.

5) Help
The following commands can be selected in the Help menu.

Contents and Index — Select this to display the Online Help.
About TOSHIBA e-STUDIO Address Book — Select this to display the version informa-
tion.
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Toolbar

You can use the following tool icon to perform various functions quickly:

(New Contact) — Click this to add a new contact in the private address book. If the cur-
rently selected item is a group, the contact will be created as a member of the group. If the cur-
rently selected item is a contact or the address book, the contact will be created in the address
book. This icon is available only when selecting items in the private address book.

3 (New Group) — Click this to add a new group in the private address book. This icon is
available only when selecting the “Group” folder in the private address book.

(Copy) — Click this to copy the selected contacts or a group in the clipboard. The con-
tacts or a group copied in the clipboard can be pasted in the private address book. This icon is
available only when selecting a group or contacts in any address book.

E (Paste) — Click this to paste the contacts or a group copied in the clipboard in the private
address book. If the group has been copied, this item is available only when selecting a “Group”
folder. If contacts have been copied, this item is available only when selecting a group or "Loca-
tion/People" folder in the private address book.

(Properties) — Click this to edit or display the properties of a group or a contact. This
icon is available only when selecting a group or a contact.

x (Delete) — Click this to delete a group or contacts in the private address book. This icon
is available only when selecting a group or contacts in the private address book.

el (Find) — Click this to find a contact by searching the address book.

4 (Download AB) — Click this to download the public address book that you modified to
this equipment. 1 P.68 “Configuring the connection by local discovery”

@ (Fax) — Click this to add the fax numbers of selected contacts as destinations to be sent
using the Network Fax Driver. (This icon is available only when accessing the Address Book
Viewer from the Network Fax Driver properties dialog box and selecting contacts.)

&2 (Mail) — Not available

§= (Confirm Selection) — Click this to display the Destinations dialog box to confirm the
destinations to be sent using the Network Fax Driver. (This icon is available only when access-
ing the Address Book Viewer from the Network Fax Driver properties dialog box and any fax
numbers have been selected as destinations.)

Running Address Book Viewer 65

Download from Www.Somanuals.com. All Manuals Search And Download.



Context-sensitive menus

You can also use the context-sensitive menu that is displayed by right-click the an item dis-
played in Address Book Viewer window.

¢ Add - Contact — Select this to add a new contact in the private address book. If the cur-
rently selected item is a group, the contact will be created as a member of the group. If the
currently selected item is the "Location/People" or the private address book folder, the con-
tact will be created in the "Location/People" folder. This command is available only when
selecting items in the private address book.

¢ Add - Group — Select this to add a new group in the private address book. This command
is available only when selecting the “Group” folder in the private address book.

* Copy — Select this to copy the selected contacts or groups in the clipboard. The contacts or
groups copied in the clipboard can be pasted in the private address book. This item is avail-
able only when selecting contacts or groups in any address book.

* Paste — Select this to paste the contacts or groups copied in the clipboard in the private
address book. This item is available only when selecting a group or the “Location/People”
folder in the private address book.

* Properties — Select this to edit or display the properties of a contact or group. This com-
mand is available only when selecting a contact or group.

* Delete — Select this to delete the selected contacts or groups in the private address book.
This command is available only when selecting contacts or groups in the private address
book.

¢ Select - Fax Number — Select this to add the fax numbers of selected contacts or groups
as destinations to be sent using the Network Fax Driver. (This item is available only when
accessing the Address Book Viewer from the Network Fax Driver properties dialog box and
selecting contacts or groups.)

* Select - EMail — Select this to add the e-mail addresses of selected contacts or groups as
destinations to be sent using the Network Fax Driver. (This item is available only when
accessing the Address Book Viewer from the Network Fax Driver properties dialog box and
selecting contacts or groups.) (This function is not available in the equipment.)

* Selection — Select this to display the Destinations dialog box to confirm the destinations to
be sent using the Network Fax Driver. (This item is available only when accessing the
Address Book Viewer from the Network Fax Driver properties dialog box and fax numbers
have been selected as destinations.)
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Managing Address Book

You can use the Address Book Viewer to manage the private address book. You can add or edit
the contacts and groups as you desire. The private address book data is stored in your client
computer. It can be used to manage the contacts and groups for sending a fax using the Net-
work Fax Driver.

The Address Book Viewer also displays a public address book that is the address book in the
compatible TOSHIBA equipment, such as this equipment, e-STUDIO3510c Series, e-
STUDIO451c¢ Series, e-STUDIO850 Series, e-STUDIO452 Series, e-STUDIO282 Series, e-
STUDIO4511 Series, e-STUDIO450 Series, e-STUDIO280 Series, and GL-1010 controller for
the e-STUDIO165/205. Using the Address Book Viewer, you can display the contacts or groups
in the address book and they can be copied to your private address book.

In addition, you can access additional address book data such as the address book application
of the default e-mail client in your computer, Microsoft Outlook address book, and an LDAP
directory service running in your network. You cannot add, delete, or edit the data in these
address book, but you can copy their address book data to paste into the private address book.

About the address books

You can manage your address book using the following address books:

* Private address book can be used as your own address book.

P.67 “Managing the private address book”

* Public address book allows you to display the address book in e-STUDIO3510c Series, e-
STUDIO451c¢ Series, e-STUDIO850 Series, e-STUDIO452 Series, e-STUDIO282 Series, e-
STUDIO4511 Series, e-STUDIO450 Series, e-STUDIO280 Series, and GL-1010 controller
for the e-STUDIO165/205.

P.68 “Managing the public address book”

* MAPI address book allows you to display the address book data of the default e-mail appli-
cation in your computer.

P.75 “Configuring the MAPI address book”

* MS Outlook address book allows you to display the address book data of Microsoft Outlook
Express in your computer.

P.75 “Managing the Microsoft Outlook address book”

* LDAP address book allows you to display the address book data which is added from LDAP
servers.

P.75 “Managing the LDAP address book”

Also the Address Book Viewer allows users to import and export the address book data as CSV
file or vCard file, so that users can import the CSV file or vCard file which exported from another
user’s private address book or public address book, and users can export the private address
book and public address book for other users.

L P.82 “Importing and exporting the address book”

Importing and exporting a vCard file is available only when Microsoft Office XP is installed on
your computer.

Managing the private address book

You can manage your own address book using the private address book. You can add, delete,
and modify the contacts in this address book. You can also create, delete, and modify groups.
Contacts and groups can be added to this address book by various ways using other address
books within the Address Book Viewer. For instruction on how to manage the contacts and
groups in the private address book, please refer to the following section:

P.86 “Managing contacts and groups”
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Managing the public address book

In order to access the public address book in e-STUDIO3510c Series, e-STUDIO451c Series, e-
STUDIO850 Series, e-STUDIO452 Series, e-STUDIO282 Series, e-STUDIO4511 Series, e-
STUDIO450 Series, e-STUDIO280 Series, and GL-1010 controller for the e-STUDIO165/205,
you must configure the connection to the device.

You can configure the connection by searching the network for the device, or entering the IP
address of the device manually.

P.68 “Configuring the connection by local discovery”

P.71 “Configuring the connection by manual selection”

After configuring the connection to the device, the address book data of the device is obtained in
the public address book. You can display the address book data and copy them in the private

address book.
For the instruction to download the public address book data into the Address Book Viewer,

please refer to the following section:
P.73 “Downloading the public address book”

— Configuring the connection by local discovery

You can search your network for the device and configure the connection.

Discovering the device and obtaining the public address book data

1 Select “Public Address Book” in the browse pane, click the [Tools]
menu, and select [Device Setting].
Eif| e-STUDIO AddressBook Yiewer =] B9

File Edit Wiew | Tools Help

LDAR Setting

[ Fa Mumber | Email Addiess |

M5 Outlook Address Book
LDAP Address Baok
Import Address Baok

|cConfigure the Device Settings Jojo

The TopAccessDocMon Local Discovery dialog box appears.
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2 Click [Start Discovery] to begin the process.

TopAccessDocMon Local Discovery x|
HName [ IPAP Address | Lacation [ Model |
Selsct ‘Start Discovery' to begin the
discoven process. Start Discovery
Advancad
Hanual Selestion
Deviee Infarmation,
o0 | caneel | Hep |

It locates all the compatible devices in your network.

* You can quit the process by clicking [Stop Discovery].

* When this equipment is on another segment, it may not be discovered. In this case,
click [Manual Selection] to discover the equipment manually.

P.71 “Configuring the connection by manual selection”

If the process continues for a long time, it is because the too many network clients are

in the network. In this case, you can configure the discovery settings from [Advanced]
button.

P.70 “Configuring discovery settings”

3 When the process completes, found printers are listed in the list.

4 Select the device that you want to access from the list and click
[OK].

5|
HName | IPAP Address | Lacation [ Model |
86 10.10.70.105 TOSHIBA &-5TL.
Select a printer for your printer. Consult
with your administiator for more
information,
Advanced.
Manual Selection
Device Infarmation,
hitg410,10.70,105.8080
o | el | Hep |

The Address Book Viewer window is displayed.
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5 Click the [Download AB] icon (@) in the tool bar.

Eif| e-STUDIO AddressBook Yiewer — o x|

Filg Edit View Tools Help

B2 B PE X e EE s

- TOSHIBA Address Book Display Hame [ Fa Mumber | Email Addiess |
Private 4ddress Book
i & ook

ic
MAP| Address Baok
M5 Outlook Address Book
LDAP Address Baok
Import Address Baok

loja

6 The Downloading dialog box appears. You can quit downloading
the address book data by clicking [Cancel].
S

Downloading contacts from MFF.....
Flease Wait..

Cancel

The Address Book Viewer connects to selected device and obtains the address book
data in the public address book.

Configuring discovery settings
You can configure the discovery settings.

Discovery Settings x|

i~ Devic

| ¥ Find e-STUDIOZ0S Series [=1

I~ | Enztiz IP/5F% Search

¥ Enabls TCPAP Search
% Search local subnet
" Specify 3 1angs

From 10 o .70 [1}
T 10 0 W 25
i3 | Cancel | Hep |
1) Devices
Click the arrow button to display the pull down list and check the model name that you want
to search.

2) Network - Enable IPX/SPX Search
This is disabled because the Address Book Viewer does not support the IPX/SPX connec-
tion.
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3) Network - Enable TCP/IP Search

Check on this to search devices that connect to the TCP/IP network. This is available only

when the TCP/IP protocol is installed in your computer.

When this is enabled, select how it searches printers in the TCP/IP network.

- Search local subnet — Select this to search devices in local subnet.

- Specify a range — Select this to search devices in specific range of IP addresses. When
this is selected, enter the IP addresses in “From” field and “To” field to specify the range.

— Configuring the connection by manual selection

You can configure the connection by entering the IP or IPX address of the device manually.

Configuring the connection manually and obtaining the address book data

Select “Public Address Book” in the browse pane, click the [Tools]
menu, and select [Device Setting].

il e-STUDIO AddressBook Yiewer

File Edit Wiew | Tools Help

=10l x|

LDAP Setting
2 2 i

Conwerting

= TOSHI Display Name

[ Fa Mumber

| Email Addiess |

Private Address Baok
lic ok

MAP| Address Baok

M5 Outlook Address Book

LDAP Address Baok

Import Address Baok

|Configure the Device Settings

loja

The TopAccessDocMon Local Discovery dialog box appears.
2 Click [Manual Selection].

TopAccessDocMon Local Discovery f x|
Name [ IPAPX Address | Location [ Madel [

Select the GL for this printer. Consult

with your admiristratar for more Start Discovery
information.

Addvanced..
Manual Selection
Device Information

hitp: 44

o |

Cancel

| Hep |

The Manual Selection dialog box appears.
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3 Enter each item to specify the printer address and click [OK].

x
IP Address: 10 10 70 105
[FX &ddress.
Mame WFP-D0CETE61
Location :
G

IP Address — Enter the IP address of the printer.

IPX Address — This is disabled because the Address Book Viewer does not support the
IPX/SPX connection.

Name — Enter the printer name.

Location — Enter the location of the printer.

You must enter “Name” and either “IP Address” or “IPX Address”.

4 Select the entered device name and click [OK].

i
| IPAP Address | Lacation [ Model |
1010.70.105
Select the GL for this printer. Consult
with your administrator for more Start Discovery
infarmation.
Advanced...
Manual Selestion
Devics Information
hitp:/10.10.70.105:8080
ok | cencel | Hep |

The Address Book Viewer window is displayed.
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5 Click the [Download AB] icon (@) in the tool bar.

Eif| e-STUDIO AddressBook Yiewer (o]
File Edit Yiew Took Heln

B2 B PE X e EE s

E-BA TOSHIBA Addiess Book Display Hame | Fax Mumber | Email Addiess |
Private 4ddress Book

c Ade s Boak
Address Book

M5 Outlook Address Book
LDAP Address Baok
mport Address Bock

loja

6 The Downloading dialog box appears. You can quit downloading
the address book data by clicking [Cancel].

Downloading... x|
Downloading contacts from MFP.
Pleass Wait

The Address Book Viewer connects to entered device and obtains the address book data
in the public address book.

— Downloading the public address book

You can download the address book data in the equipment to the Address Book Viewer.

The Address Book Viewer downloads the address book data that is backed up in the equipment
using TopAccess through FTP. Backing up the address book data can be operated by an admin-
istrator. If the address book data is old, please ask your administrator to backup the address
book data.
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Downloading the public address book data

1 Click the [File] menu, select [Download], and select the device
name that you want to download the address book.

Eif e-STUDID Address Book Viewer =10l x|

File Edit Wiew Tools Help

Mews Contack

New Group E x R ZE A=

Froperties Ess Book Display Name [ Fax Number [ Email Address [
Delete el ress Book

|4 ® MFP-00C67861
MFR-00CS4786

Import

Export
Exit

[MFP-o0CE7EE1 [The tatal number of the contacts: 0fz000

2 Select “Public Address Book” in the browse pane.

3 The Downloading dialog box appears. You can quit downloading
the address book data by clicking [Cancel].
=

Downloading contacts fram MFP.
Please \wait

Cancel

The public address book data is downloaded from the selected device.
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Configuring the MAPI address book

The Address Book Viewer automatically accesses the address book application of the default e-
mail client software using the Messaging API (MAPI).

If the Address Book Viewer prompts an error message when selecting the MAPI address book,
the default e-mail client software has not been defined in your computer, or the default e-mail
software does not support MAPI. In this case, set the MAPI-compliant e-mail software as the
default e-mail client. For instructions on how to set your e-mail application as default e-mail cli-
ent, refer to the documentation or online help of your e-mail application.

You can use the MAPI address book to copy the contacts and groups to the private address
book.

3 P.90 “Copying contacts from an address book”

Managing the Microsoft Outlook address book

The Address Book Viewer automatically accesses the Microsoft Outlook Express address book
to obtain the address book data. You use the MS Outlook address book to copy the contacts and
groups to the private address book.

P.90 “Copying contacts from an address book”

Managing the LDAP address book

In order to access to the address book data in the LDAP servers, first you must register the
LDAP directory services that you want to access.

P.76 “Registering the LDAP directory services”

Then search contacts in the LDAP server and add the contacts to the LDAP address book.
P.78 “Adding contacts from LDAP servers”

You can use the LDAP address book to copy the contacts to the private address book.

D P.90 “Copying contacts from an address book”
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— Registering the LDAP directory services

You can register multiple LDAP directory services.

Registering the LDAP directory services

1 Click the [Tools] menu and select [LDAP Setting].

Eif e-STUDIO AddressBook Yiewer =lox|
File Edt View | Taols Help
L
Device Setting | 0¥ 42 02 ¢=
Converting
Display Mame [ Fas Number [ Email &dhess [
rivate Address Baok
ublic Address Book.
4P| Addiess Book
55 Book
|Configure the LDAP Settings [The tatal number o the contacts: 0/2000

The Internet Account dialog box appears.

2 In the General tab, enter the items as described below.

Internet Account x|
General | Advanced |
Directar Server Name:
[idap.ifax com
[V This Server rsquires me talog on
Account Name: |
Password [
I~ Log on using Securs Passward Authentication
Character code selting: Bs0l - |

Add

Dirsctary Service

Account |

femeve | Cose | Hep |

Directory Server Name — Enter the server name or IP address of a LDAP server.
This Server requires me to log on — Check this if the LDAP server requires the user
name and password to log on.

Account Name — Enter the user name to log on the LDAP server.

Password — Enter the password to log on the LDAP server.

Log on using Secure Password Authentication — Check this to use secure password
to log on the LDAP server.

Character code setting — Select the character code for the LDAP server.
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3 In the Advanced tab, enter the items as described below.
x

Gerersl  Advanced |

i~ Setver Port Mumber

Directary servicelLDAP): 389

I~ This Server requires a sscurs connection(35L)

[~ Search

Search timsoutminutes)

=] =
8
J

Masimum number of matches to return:

SeachBase: | |
Add

Directary Service

Acoourt |

Aemoe | Cose | Help |

Server Port Number - Directory service (LDAP) — Enter the port number to access
the LDAP server. It shows “389” as a default. Change this number if you are sure the
LDAP port number is changed from the default port number on the LDAP server.
Server Port Number - This Server requires a secure connection (SSL) — Check this
when you require to access the LDAP server using SSL.

Search - Search timeout — Select the timeout interval for searching.

Search - Maximum number of matches to return — Select maximum numbers for the
search results.

Search - Search Base — Enter the search root suffix.

4 Click [Add].

The entered directory service is added to the Directory Service list.

Repeat the procedure from Step 2 to Step 4 until all required direc-
tory services are added.
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— Adding contacts from LDAP servers

After you register the LDAP directory services, you can search contacts in the LDAP servers and
add preferred contacts to the LDAP address book.

You can search contacts by the name and fax number. Also you can search contacts by specify-
ing the detailed search conditions.

Searching contacts by name and fax number

1 Click the [Edit] menu and select [Find].

Eif e-5TUDID AddressBook Viewer =10 x|

File | Edit View Tools Help

Copy  ChitC

2 e by XK@ R B E E
[2 Select Al Cerbes ok
Find ook,
I
AP Address Book

S Outlook Address Book
 Address Book

Display Name [ Fax Number [ Email Address [

Address Eool
mport Address Book

[Search for contacts [The total number of the contacts: 02000

The Find Contact dialog box appears.

2 Select a registered directory service in the “Data Source” drop
down box.

Find Contact x|

Data Source: Privale Address Book =l
Fiivate Addiess Book
Person | Dietail 54 Public Addiess Bock
MAPI Address Book
: M5 Dutlack Address Baok
Display Mame: | |mport Addiess Bogk
Far Number:

E-Mail: [

78 Managing Address Book

Download from Www.Somanuals.com. All Manuals Search And Download.



Display the Person tab and enter search text in the following fields
that you require.

ﬂ
DetaSouce: | e e com |
Person | Dictail Seting |
Display Name: Juser
Far Number: [
E-Mail [
Search
Siop |
Giroup Name | Display Name: [ Fax Number [ Email Address |
4] | |
addiess | Cearal | | Cose | Hep |

Name — Enter the search characters or string to search by the contact name.

Fax Number — Enter the search characters or string to search by the contact fax
number.

E-Mail — Enter the search characters or string to search by the contact e-mail address.
(This item is not available in the equipment.)

You must enter data into one of the fields to search contacts. It will search the contacts
that contain the entered search strings.

Tip
If you want to clear entered values, click [Clear All].

Click [Search].

It begins searching contacts in the LDAP server. When it completes searching, found
contacts appears in the list at the bottom of the dialog box.

Tip

If you want to stop searching, click [Stop].
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5 Select contacts that you want to add to the LDAP address book,
and click [Add].
=

DetaSouce: | e e com |

Person | Detai Setting|

Display Mame: USER

Far Mumber: I

E-Mail: I

Search

Siop |

Graup Name: Display Wame Fax Number

User USERDI T, u

Addiess | Cearal | add | Cose | Hep |

The selected contacts are added to the LDAP address book.

Searching contacts by detailed search conditions

1 Click the [Edit] menu and select [Find].

il e-STUDIO AddressBook Yiewer

File | Edit View Tools Help
Copy.  CHiC

2 opme by [X BB B E =

[2] seletallcubia bk Display Hame  Fa Mumber [ Emal Addiess [

ok
ook

MAP| Addiess Book

=10l x|

[Search For contacts [The tatal number o the contacts: 0/2000

The Find Contact dialog box appears.

2 Select a registered directory service in the “Data Source” drop
down box.

Find Contact x|

D ata Source: Private Address Book j

Fiivate Addiess Book
Perzon | Detail S& Public Address Bock
M&P! Address Book

M5 Outlook Address Book
Display Mame: || rrort Address Book,

Fax Humber:

E-tail: |
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3 Display the Detail Setting tab and select a field to search in the
“Field Select” drop down box.

Field Select: Condition of search string:
IDispIay Mame ﬂ IEontains j I

Fax Humber

Email Address Add
First Mame

Stan |

Select how it searches contacts in the “Condition of search string”
drop down box.

Field Select: Condition of search string:

IDispIay Mame j IEontains j I

Condition list:

Add

atan |
Contains — Select this to search contacts that contain the search string.

Is — Select this to search contacts that completely match the search string.
Start with — Select this to search contacts that start with the search string.
End with — Select this to search contacts that end with the search string.

Enter the search string in the next field to the “Condition of search
string” drop down box.

Field Select: Condition of search string:
IDispIay Mame j IEontains j IUseri
Condition list:
Add

Ston |

Click [Add].

Specified search condition is added to the condition list.
Tip
If you want to clear entered values, click [Clear All].

Repeat the procedure from Step 3 to Step 6 to add all required con-

ditions.
Field Select: Condition of search string:
IDispIay Mame j IEontains j IUser
Condition list:
Dizplay Mame Contains Jser Add
Delete | ﬂl
Ston |
Tip

You can remove the search conditions you have added. To do this, select the condition
and click [Delete].
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Click [Search].

It begins searching contacts in the LDAP server. When it completes searching, found
contacts appear in the list at the bottom of the dialog box.

Tip
If you want to stop searching, click [Stop].

9 Select contacts that you want to add to the LDAP address book,
and click [Add].

Find Contact x|
DetaSouce: | e e com |

Persan  Detai Setiing |

Define Condition,

Field Select: Condition of search string:

Display Mame = Containg | |User

Condition list:

Diisplay Name Contains User Add

bete

Siop |

Graup Name Display Wame Far Number Email Address

il

addiess | Cearal | add | Cose | Hep |

The selected contacts are added to the LDAP address book.

Importing and exporting the address book

The Export feature of the Address Book Viewer allows you to create a CSV file or vCard file of
your selected address book, and it can be imported to other user’s Address Book Viewer. The
Import/Export feature is useful when users want to share the address book data.

e The CSV file to import the Address Book Viewer must be created as the comma separated
file in the following format:

Group Name,Contact Key,Prefix,First Name,Last Name,Suffix,Display Name,Company Name,Department Name,First Fax
Number,Second Fax Number,Email Address,Furigana,One Touch ID,Notes,Attenuation,Error Correction Mode,Fax Mode,Line
Monitor,Line Selection,Option Type,Oversea Calls,Print Transmission Report,Short Protocol, Transmission
Type,UseDeviceSettings,UseSubAddSID,Compression,PageWidth,Resolution,Password,Senderldentification, SEP,SubAddress
,1,,User01,User,,User01 User,12345COMPANY,Dept01,00000000001,,user01@ifax.com,,1,,0,1,0,0,2,0,0,0,0,1,0,0,0,0,0,,,,
,2,,User02,User,,User02 User,12345COMPANY,Dept02,00000000002,,user02@ifax.com,,2,,0,1,0,0,2,0,0,0,0,1,0,0,0,0,0,,,,
Group1,1,71,,,000msmsmsssssssssssssnsns

For more information about the format, please contact your service engineer.
* Importing and Exporting a vCard file is available only when Microsoft Office XP is installed on
your computer.

Tip
If any data is lost during importing, confirm the following:

- Both the First Name and Last Name are not blank.
- Both the E-mail address and Fax number are not blank.

Also you can use the import address book to copy the contacts and groups to the private
address book.
P.90 “Copying contacts from an address book”
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Importing the address book from a CSV file or vCard file

Address book files that are exported from GL-1010 or GL-1020 using TopAccess cannot be
imported to the Address Book Viewer.

1 Click the [File] menu and select [Import] and [CSV File] or [vCard

File].
Eif| e-STUDIO Address Book Viewer =101x|
File Edt View Tools Help
New Contact E
New Group G RE
Froperties Ess Book Display Name [ Fax Number | Email Address [
Delete D2l fress Book
less Book
Download e Bouk
Export b wCardFils
Exit
[Tmpart the contacts from a csv file [The tatal number of the contacts: 0fz000

The Importing dialog box appears.

The [vCard File] command will appear only when Microsoft Office XP is installed on your
computer.

2 Locate the folder where the CSV file or vCard file is stored, and
select the file type (CSV or vCard) in the “Files of type” drop down
box. Then select the file and click [Open].

Importing... 2lx|
Look in: | (=3 AddressBook JE3 = e
File name:  [addidata Open |
Files of type: |csv [Comma Separated Values) [ese] 7| Cancel
I~ Open s 1ead-only
A
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3 The address book data is imported into “Import Address Book”.

Eifl e-STUDIO AddressBook Yiewer I =] 9]
Filg Edit View Tools Help
22 B RBE X @ EE:E
E] HIBA Addiess Book Display Hame [ Fa Mumber | Email Addiess -

Private Address Book TR = User Lser 00000000001 user01 @ifax.com
Fublic Address Book B User Userdz 00000000002 user02@ifax.com
MAP| Addess Book B User Use3 00000000003 useiD3@itar com
MS Outinck Addrsss Book B User serld 00000000004 useil4Gifar. com
LDAP Adress Book B User Userls 00000000005 userd5@ifar com
B User Userde 0000000006 userDB@iar com
& 00000000007 user07@ifax.com
000000000% userDB@iar com
00000000009 user09@ifax com
0000000010 user] D@itar, com
00000000011 user! 1 @ifax.com
0000000012 user] 2@iar com
00000000013 user! 3@ifax.com
000000001 4 user 4@itar, com
00000000015 user S@ifax.com
0000000016 user| B@iar com

00000000017 userl 7@iancom
B User Userls 0000000018 user] B@iar. com
B User User1g 00000000019 user! S@ifax com

ﬁl?‘ aer sepr NN nser 2N A ~om I —"LI

[ [The tatal number of the contacts: 222000

If you have already been import an address book before, contacts information is
overwritten to the existing import address book.

Tip
If one or more records have been skipped during the import process, it may be due to
one of the following reasons:
- Record already exists.

- Group name contains an invalid character.
- Fax number is invalid.
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Exporting the address book as a CSV file or vCard File

1 Click the [File] menu and select [Export] and [CSV File] or [vCard

File].

Eifl e-STUDID Address Book Yiewer

=10

[File Edit View Toos Help
Mews Contack
New Group x @R 2 A=
Froperties 53 Book Display Name [ Fax Number | Email Address -
Delete Del = User Userdl 00000000001 userd @ifar.com
Dowrload y [pes Bock B User Userd2 noonooonnnZ Usei02@itar.com
B User Userd3 00000000003 userD3@iar com
NiEetid 4 B User User4 00000000004 useld@itax.com  —
B User Useds 00000000005 Use05@itar.com
e B User Userls 00000000006 usel6@itax.com
= User Userd? 00000000007 userD7 @iar com
B User Userds 00000000008 user0B@itar com
= User Userdd 00000000003 userD3@iar com
B User User10 00000000010 user] O@itar com
= User Userl1 00000000011 userl1@iar com
B User User12 00000000012 user] 2@itar com
B User Userl3 00000000013 user] I@iar. com
B User User1d 00000000014 user] 4@itar com
B User Userls 00000000015 user]5@iar com
B User UserlE 00000000016 user16@itar com
B User Userl 7 00000000017 user] 7@iar com
B User User1s 00000000018 user1B@itar com
00000000019 user] 9@iar com

ANANANANN11

Va2 Rk My.]

il

[Expart the contacts to a csv file

[The tatal number of the contacts: 992000

The Exporting dialog box appears.

The [vCard File] command will appear only when Microsoft Office XP is installed on your

computer.

2 Locate the folder where you want to save the CSV file or vCard File,
and select the file type (CSV or vCard) in the “Save as type” drop
down box. Then enter the file name and click [Save].

Exporting... ]

Savein: | (3 AddressBook

x| = E ek E-

21x

File name:  [addidata

Save I

Save as type: [CSY (Comma Separated Values) ['csv] x| Cancsl
pA

The private address book is exported as a CSV file or vCard file.
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Managing contacts and groups

Users can create contact and group entries to the private address book that can be accessed
from your desktop.

Under the Private Address Book folder, there are two containers, “Group” and “Location/Peo-
ple”.

The “Location/People” folder contains individual contact information. The Group folder contains
the groups and it can contain the individual contact information in each group.

Managing contacts

You can add contacts to the “Location/People” folder and each created groups in the private
address book.

There are several ways to add the contact to the container.

P.86 “Adding contacts manually”

P.90 “Copying contacts from an address book”

Also you can modify or delete contacts in the private address book.

P.91 “Displaying or modifying contacts properties”

P.95 “Removing contacts”

— Adding contacts manually

You can add new contacts to the “Location/People” folder in the private address book. Also you
can add new contacts to groups created in the private address book.

Adding a new contact manually

1 Select the folder that you want to add new contact in the left pane.

Eif e-5TUDIO AddressBook Yiewer =|0] x|
File Edt WView Tooks Help

BE BBRE X QR E EE

=) TOSHIBA Addiess Book Display Name | Fax Number | Email Address |
£ Private Address Book
2 Group

enple]
Public Address Book
MAP| Addiess Book
M3 Dutlook Addiess Book
LDAP Addiess Book
mport Address Book

[ [The total number of the contacts: 02000

* If you want to add new individual contact in the private address book, select the
“Location/People” folder under “Private Address Book” folder.

* If you want to add new contact to the group in the private address book, select a
group that you want to add a contact in the “Group” folder under “Private Address
Book” folder.
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2 Click the [File] menu and select [New Contact].

Eif e-STUDIO AddressBook Yiewer ] 5 |
Fle Edt View Tools Help
[ ntact b
New Graup *x R 2 A =
Propertics fess Book Display Hame [ Fa Mumber | Email Addiess |
Delete De| ress Book
Download 3
ple
Import b [ess Book
Export b pss Book
Exit Address Book
T e emtess Book
Import Address Book
[Add & Mew Contact [The tatal number o the contacts: 0/2000

The New Contact dialog box appears.
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3 In the Personal tab, enter items as described below.

B
Personal | Sending Options |

One Touch D:

Prefis: First Mame: Last Marne: Suffix

M =] [Tomopki Take -

Display Name

|M| Tamoyuki Take |

Company Department:

|aBCOEFG #BC

Fan

| ERRARRRRAR

Second Fax

1

E-Mail Address

[take@ifax conl

Notes

ok | concel | hep |

One Touch ID — Select the one touch ID number for the contact (if desired).

Prefix — Select the prefix for the contact.

First Name — Enter the first name of the contact. You can enter up to 32 characters.
Last Name — Enter the last name of the contact. You can enter up to 32 characters.
Suffix — Select the suffix for the contact.

Display Name — The display name is automatically entered as “[Prefix] [First Name]
[Last Name] [Suffix]”. You can also edit the name as you prefer. You can enter up to 70
characters.

Company — Enter the company name of the contact. You can enter up to 64 characters.
Department — Enter the department name of the contact. You can enter up to 64
characters.

Fax — Enter the 1st fax number of the contact. You can enter up to 128 characters
includes numbers and the following symbols: +, -, *, #

To add a 3 second pause to a fax telephone number, place a hyphen (-) at the desired
point in the number.

Second Fax — Enter the 2nd fax number of the contact. You can enter up to 128
characters includes numbers and the following symbols: +, -, *, #

To add a 3 second pause to a fax telephone number, place a hyphen (-) at the desired
point in the number.

E-mail Address — Enter the e-mail address of the contact. You can enter up to 192
characters. (E-mail reception is not available in the equipment.)

Notes — Enter any notes for the contact. You can enter up to 256 characters.

You must enter either “First Name” or “Last Name”, and either “Fax” or “E-mail Address”.
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In the Sending Options tab, enter items as described below as

required.

New Contact

Personal - Sending Optians |

¥ | Use Device Settings.

Fax

Sub Address:

I~ ilise Sub Addiass and sender infomation

Sender |dentification:

Selective Polling:

Password:

—Fax Options.
I Oversea Calls ™| Rieduction
I=| Enror Carrection Modz I= | Shart Protocol:
™| Erirt Transmission Beport: ™| Line Moritar

Line Selection: Transmission Type
’Vr-‘ Linekl € Linetiz ’Vr-‘ Direct € bemoy

~Intemet Fax Option:

X

Intemnet Fax Mode: Selting Value:
{(-‘ Simple € Full (ﬁ‘ Default € Custom

Fscew Capabiity:

Resolution Compression Page Width:

0k | Cancel | Heb |

Use Sub Address and sender information — Check this to enable subaddress
transmission for this contact. When this is checked, documents will be always sent using
the specified sub address and

SID. Also you can use this contact to perform polling transmission from the mailbox in the
remote facsimile using the specified sub address and password.

Sub Address — Enter the sub address or mailbox number of remote facsimile where a
document will be sent. This can be entered only when “Use Sub Address and sender
information” is enabled.

Sender Identification — Enter the security password for the sub address if required.
This can be entered only when “Use Sub Address and sender information” is enabled.

Other items in this tab cannot be modified.

B Click [OK].

The contact is added to the list in the selected folder.
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— Copying contacts from an address book

You can also add contacts to the private address book by copying contacts from another
address book folder.

Copying contacts from another address book folder

1 Browse to the folder that contains the contacts you want to copy,
and select the contacts in the right pane.

2 Click the [Edit] menu and select [Copy].

Eifl e-STUDIO Address Book Yiewer I =] 3]
File | Edt View Tooks Help
B raste cuby | AR B E =
(2 Selectal Cwbra Loy [ Fa Mumber | Email Addiess -
s ook 00000000001 userD1 @itar com
ook 0000000002 userD2@iar com
4P| Addvess Book 00000000003 user03@ifax.com
5 Outiook Address Book Q0000000004 weld@iancom  —
DAP Address Book nnnnnnnnnn user05@itar com
mport Address Book 00000000006 LseiDB@itar.com
00000000007 useD7@itar com
000000000% userDB@iar com
00000000009 userI@itar com
0000000010 user] D@itar, com
00000000011 user11@itax com
Q0000000012 user] 2iar com
00000000013 user] 3@iar com
000000001 4 user 4@iar com
00000000015 user15@itax com
Q000000001 & user| B@iar com
00000000017 user] 7@itax com
000000001E user] B@iar com
00000000019 user1 9@itar com
NN 1iser 25w Frm] _'j
»
[Copy the contacts or group [The tatal number of the contacks: 991000

The selected contacts are copied in the clipboard.

3 Browse the Private Address Book and select a folder that you want
to add the copied contacts in the left pane.

* If you want to copy individual contacts in the private address book, select the “Loca-
tion/People” folder under the “Private Address Book” folder.

* If you want to copy contacts to the group in the private address book, select a group
that you want to add contacts in the “Group” folder under the “Private Address Book”
folder.

4 Click the [Edit] menu and select [Paste].

Eif| e-STUDIO Address Book Yiewer — o x|

File | Edit View Tools Help

Chrl+C

D selecoall cirlth bok Display Name [ Fa Number | Email &dhess I
Find

1AP| Address Book
5 Outlook Address Baok
DAP Address Book
mport Address Bock

|Paste the copied contacts or group [The tatal number of the contacts: 0f2000

Copied contacts are added to the list in the selected folder.
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— Displaying or modifying contacts properties

You can display the properties of contacts in any address book. You can also edit the properties
of contacts in the private address book.

Displaying or modifying the contact properties

1 Browse to the folder that contains the contacts you want to display
or modify, and select the contact in the right pane.

2 Click the [File] menu and select [Properties].

i e-STUDIO Address Book Yiewer

Fle Edt View Tools Help
ey Contack
ey Group

Dovinload

Import
Export
Exit

=10l x|

s Book.
re:ss Book
53 Book
55 Book
Addiess Book
Fss Book
53 Book.

E’X@@@Eéz

[ Fa bumber

| Email Addiess

Display Name
& =1
= User Userl2
B User Use3
B User Userd
B User Usels
= User Userls
B User Usel?
B User Userl
B User Used
= User Userl
B User Userl
B User Userl2
B User User13
B User Userl 4
B User Userls
B User Userle
B User User17
= User Userls
B User Usen1g

ﬁl?mw. Hereo
4

00000000007
00000000002
00000000003
00000000004
00000000005
00000000006
00000000007
00000000008
00000000003
00000000010
00000000011
00000000012
0000000001 3
00000000014
0000000001 5
0000000001 &
0000000001 7
0000000001 &
00000000013
ANAAANANN

user01@itax com
userD2@ifax.com
user03@itax com
userD4@ifax.com
user05@itax com
userDB@ifax.com
user07@itax com
userDB@ifax.com
user09@itax com
user Di@ifax.com
user!1@itax com
user 2@ifax.com
user] 3@itax com
user! 4@ifax.com
user] 5@itax com
user! B@ifax.com
user] Fi@itax com
user] B@ifax.com
user] 3@itax com
Ve i A mn]

il

|Display the properties of the selected contact or group

[The tatal number of the contacks: 991000

The Properties dialog box appears.

In the Properties dialog box, you can modify the settings of the contacts in the private address

book only. When you display the Contact dialog box of the contacts in any other address books,
you cannot modify the settings.
The Properties dialog box contains the Personal tab, Sending Options tab, and Security tab.

Tip

The tabs that will be displayed vary based on the type of the address book that the contact is

chosen from.
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Personal tab
In the Personal tab, the following items are displayed:

B
Personal | Sending Options |

One Touch D:

Prefis: First Mame: Last Marne: Suffix

W =] [Tomomii Take -

Display Name

|M| Tamoyuki Take |

Company, Department:

[sBCOEFG #BC

Fau

| KERNRRRRREE

Second Fax

I

E-Mail Address:

[takeifas conf

Notes

ok | concel | hep |

Tip

When displaying the properties of a contact in the private address book, you can modify all
items.

* One Touch ID — Display the one touch ID number for the contact.

* Prefix — Display the prefix for the contact.

* First Name — Display the first name of the contact.

* Last Name — Display the last name of the contact.

» Suffix — Display the suffix for the contact.

* Display Name — Display the display name of the contact.

* Company — Display the company name of the contact.

* Department — Display the department name of the contact.

* Fax — Display the 1st fax number of the contact.

* Second Fax — Display the 2nd fax number of the contact.

¢ E-mail Address — Display the e-mail address of the contact. (E-mail reception is not avail-
able in the equipment.)

* Notes — Display the notes for the contact.
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Sending Options tab
In the Sending Options tab, the following items are displayed:

New Contact

Personal Sending Optins |

¥ | lise Devine Settings

x|

- Fax

Sub Address:

™ e Sub &ddiess and sender information

Sender |dentification.

Selsctive Poling

Password:

- Fax Options
I=| Dversea Calls
I~ Encr Conection Mode

= Frint Transmission Feport:

I~ | Reduction
I~ | Shert Protocol:
I™ | Line Manitor

Line Selection: Transmission Type
’76‘ Linehl € Line#iz (ﬁ‘ Dieet € blemow

~ Intemet Fax Option

Internet Fax Mode: Setting Y alue:
’76‘ Simgle. € Full ’V(-‘ Default £ Custar

"Fﬁecewer Capability:

Resolution Comprsssion Page Width:

0k | Concel | e

Tip

When displaying the properties of a contact in the private address book, you can modify the fol-
lowing settings:

Use Sub Address and sender information
Sub Address
Sender Identification

Use Device Settings — This is checked when the contact is set to use the device settings
rather than using the settings on this tab.

Use Sub Address and sender information — This is checked when the subaddress trans-
mission for this contact is enabled. When this is checked, a document will be always sent
using the specified sub address and SID. Also you can use this contact to perform polling
transmission from the mailbox in the remote facsimile using the specified sub address and
password.

Sub Address — Display the sub address or mailbox number of remote facsimile where a
document will be sent.

Sender Identification — Display the security password for the sub address if required.
Selective Polling — Display the mailbox number of remote facsimile where a document will
be retrieved.

Password — Display the password for the selective polling if required.

Overseas Calls — This is checked when calling the contact fax number will be oversea call.
Error Correction Mode — This is checked when the ECM for this contact is enabled.

Print Transmission Report — This is checked when printing the transmission report after
the transmission is enabled.

Reduction — This is checked when the attenuation is enabled.

Short Protocol — This is checked when the short protocol is enabled.

Line Monitor — This is checked when the Line Monitor for the fax transmission is enabled.
Line Selection — Display whether the line 1 or line 2 is used for the fax transmission. The
line 2 can be selected only when optional Line 2 board is installed.

Transmission Type — Display whether the memory transmission or direct transmission is
used for the transmission.

Internet Fax Mode — Display whether the simple mode or full mode is used for the Internet
Fax transmission. (E-mail reception is not available in the equipment.)
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* Setting Value — Display whether to use auto detect receiver capability or manual settings
for the Internet Fax transmission. When “Default” is selected, it enable auto detect receiver
capability for the Internet Fax transmission. When “Custom” is selected, it uses custom set-
tings specified in the “Receiver Capability” option for the Internet Fax transmission. (E-mail
reception is not available in the equipment.)

* Receiver Capability — Display the receiver capabilities settings, such as resolution, com-
pression, and page width. These are applied to the transmissions only when “Custom” is
selected in the “Setting Value” option.

Security tab
In the Security tab, the following items are displayed:

Whether this tab appears or not depends on the address book being used.

5|

Personal | Sending Optians  Secuiy |

Qwner:

Fassword,

Editing Date

20031001154727

Close Help

¢ Owner — Display the owner name of this contact.
¢ Password — Display the password of this contact.
* Editing Date — Display the date that this contact is created.
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— Removing contacts

You can remove contacts from the private address book.

Removing contacts from address book

1 Browse the folder that contains contacts you want to remove, and
select contacts in the right pane.

2 Click the [File] menu and select [Delete].

-STUDIO AddressBook Yiewer:

File Edit View Tools Help

ey Contack
ey Group

Properties

Delete

Dovinload

Import
Export
Exit

=10l x|

F’X@ﬁ?@lﬁéz

55 Book

re:ss Book
53 Book.

55 Book
Addiess Book
Fss Book
53 Book.

[ Fa Mumber

| Email Addiess

00000000007
00000000002
00000000003
00000000004
00000000005
00000000006
00000000007
00000000008
00000000003
00000000010
00000000011
00000000012
0000000001 3
00000000014
0000000001 5
0000000001 &
0000000001 7
0000000001 &
00000000013
ANAAANANN

user01@itax com
userD2@ifax.com
user03@itax com
userl4@ifax.com
user05@itax com
userDB@ifax.com
user07@itax com
userlB@ifax.com
user09@itax com
user Di@ifax.com
user!1@itax com
user 2@ifax.com
user] 3@itax com
user! 4@ifax.com
user] 5@itax com
user! B@ifax.com
user] F@itax com
user] B@ifax.com
user] 3@itax com
Ve ik AY om

o

Delets the selected contacts or group

[The tatal number of the contacts: 222000

The Confirmation Deletion dialog box appears.

3 Click [Yes].

@ Are you sure you want to delete the selected contacts?

Yes I

no | canel |

The selected contacts are deleted.
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Managing groups

You can add groups to the “Group” folder in the private address book. Groups can be used for
multiple transmission.

P.96 “Creating groups”

Also you can modify or delete contacts in the private address book.

P.98 “Modifying groups properties”

P.99 “Removing groups”

After you create a group, you can add or delete contacts in the group. For the instruction to add

contacts in a group, please refer to the following section.
P.86 “Managing contacts”

— Creating groups

You can create groups in the “Group” folder in the private address book.

Creating groups

1 Select the “Group” folder in the “Private Address Book” folder.
2 Click the [File] menu and select [New Group].

Eif| e-STUDIO AddressBook Yiewer — o x|

[File Edit View Took Help
Mews Contact
*x bR B E =
Properties Les Book - T

Delete DEl ress Book.
Download ¥ |Pecple
Import b [ess Book
E— » pssBook
Ext Address Book
P Tomrmosss Book
Inport Address Baok

[Add & New Group [The total number of the groups: 050

The Group dialog box appears.

96 Managing Address Book

Download from Www.Somanuals.com. All Manuals Search And Download.



3 Enter a group name in the “Group Name” field.
eow =i

Group |

Type & name for your gioup

Group ID: Group Kame:
i Group(Tl

0K | Concel | Hep |

The “Group ID” field displays the Group ID number automatically detected.
Click [OK].
The group is created in the selected “Group” folder.

Continue to add contacts to the group.
P.86 “Managing contacts”
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— Modifying groups properties

You can change the group name of the groups in the private address book. You can also display

the properties of a group in the public address book.

You cannot modify the group of the public address book.

Modifying the group properties

1 Select the group that you want to display or modify the group prop-
erties in the “Group” folder either of the private address book and

public address book.

2

il e-STUDIO AddressBook Yiewer
File Edit View Tools Help

Click the [File] menu and select [Properties].

=10l x|

N Contack
ey Group

Properties

Display Mame
TR = User Lser
B User Userl2
B User Use3
B User Userd
B User Userls
= User Userls
B User Usel?
B User Userl
B User Used
= User Userl

Delete
Dovinload »

Import 3
Export »
Exit

B Location/People
Public Address Baok
MAP| Address Baok
M5 Outlook Address Book
LDAP Address Baok
Import Address Baok

[ Fa Mumber | Email Addiess |
00000000007 user01@ifax.com
0000000002 userD2@iar com
00000000003 userD3@ifax.com
0000000004 userD4(@itar com
00000000005 userD5@ifax. com
0000000006 userDB@iar com
00000000007 userl7@ifax.com
000000000% userDB@iar com
00000000003 userD3@itax. com
0000000010 user] D@itar, com

|Display the properties of the selected contact or group

[The total member of this group: 10/400

The Group dialog box appears.

[OK].

Group |

Type & name for your gioup

x|

Group ID Giroup Name:
il [Group0a
Display Name | Fax Number [ Email Address -
User Userld 00000000010 userl0@ias com
User Userlld 00000000003 userDS@itan com
User Userlis 00000000003 user08@ias com
User Userll? 00000000007 user07i@itas com
User Userl 00000000005 userDi@ias com
User Userlls 00000000005 userD5@itan com L
User Userli 00000000004 userldi@ias com
User Userll3 00000000003 userD3@itan com =
< | ;l_l

Group Members: 10

[ ok | coeel | Hep |
The group name of selected group is modified.

When you display the properties of the group in the private address
book, modify the group name in the “Group Name” field and click
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— Removing groups

You can delete groups in the private address book.

When you delete a group, contacts added in the group are also deleted.

Removing a group

1
2

Select the group that you want to delete in the “Group” folder of the

private address book.

Click the [File] menu and select [Delete].

Eif| e-STUDIO AddressBook Yiewer =101 x|
File Edit ‘iew Tools Help
Mew Contack
Mew Graup X R 2 A =
Display Hame [ Fa Mumber | Email Addiess |
T ] Lser Lzl 00000000001 user1 @iax com
Downioad b EE User ser2 00000000002 userl2@ifar. com
B User Use3 00000000003 userd3@ifar com
Wit L B User Userdd 0000000004 userl4@ifas.com
Export 4 B User Userls 00000000005 useiDS@itax com
| B T User Lseis 00000000006 user0B@ifax.com
B oniPennie B User Usel? 00000000007 user07@ifax.com
5 P T User seia 00000000002 userl8@ifar. com
ublic Address Baok p=
MAP) B User Used 00000000009 user09@ifax com
ress Book — i
M5 Outlook Address Book EE User Userl 00000000010 user! O@ifax. com

LDAP Address Baok
Import Address Baok

Delets the selected contacts or group [The tatal member of this group: 10400

The Confirm Deletion dialog box appears.

Click [Yes].
X

@ Are you sure you want to delete the selected group?

Yes I Mo | Caneel |

The selected group is deleted.
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Searching contacts

In order to quickly locate contacts you can search the address book database. You simply type
in a string or letters to be used to search the database. The Address Book Viewer will search for
any entry that contains the specified string.

You can search contacts by the name and fax number. Also you can search contacts by specify-
ing the detailed search conditions.

Searching contacts by name and fax number

1 Click the [Edit] menu and select [Find].

Eif e-STUDID AddressBook Viewer =10l x|

File | Edit View Tools Help

Copy  ChitC
2| paste iy

[2] Selectal clen Display Name [ Fa humber [ Email Addhess |

MAP| Addiess Book
M3 Dutlook Addiess Book
LDAP Addiess Book
Import Address Book

[Search for contacts Jojo

The Find Contact dialog box appears.

2 Select an address book to search contacts in the “Data Source”
drop down box.

I
DetaSource: | Public Address Baok =l

Fiivate Addiess Book
Persan | Detail S 4N ok

MAF! Address Bool

. M5 Outlook Address Book.
Display Mame: | import Address Book

Fax Number:  LIdap ¢4 com

E-Mail: | |

Tip

The default address book in the “Data Source” can be set by selecting [View] - [Default
Configuration] - [Data Source] from the menu bar.
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Display the Person tab and enter search text in the following fields
that you require.

ﬂ
DataSource: | Public Addhess Book |
Person | Dictail Seting |
Display Name: [Uker0l
Far Number: [
E-Mail [
Search
Siop |
Giroup Name | Display Name: [ Fax Number [ Email Address |
4 | i
addiess | Cearal | | Cose | Hep |

Name — Enter the search characters or string to search by the first name.

Fax Number — Enter the search characters or string to search by the contact fax
number.

E-Mail — Enter the search characters or string to search by the contact e-mail address.
(This item is not available in the equipment.)

You must enter one of the field to search contacts. It will search the contacts that have
exactly same name or fax number as the entered search strings.

Tip
If you want to clear entered values, click [Clear All].

Click [Search].

It begins searching contacts in the selected address book. When it completes searching,
found contacts appear in the list at the bottom of the dialog box.

Tip

If you want to stop searching, click [Stop].
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Searching contacts by detailed search conditions

1 Click the [Edit] menu and select [Find].

Eif| e-STUDIO AddressBook Yiewer — o x|

File | Edit View Tools Help

Copy.  CHiC
2 paste b

[2] selcal cilia Display Mame [ Fa Mumber | Email Addiess [

MAP| Address Baok
M5 Outlook Address Book
LDAP Address Baok
Import Address Baok

[Search For contacts loja

The Find Contact dialog box appears.

2 Select an address book to search contacts in the “Data Source”
drop down box.

x4
D ata Source: IF'ub\ic Address Book j

Private Addiess Book,
Person | BEETRT: P biic &ddress Book
M&PT Address Book
M5 Outlook Address Book
Dizplay Mame: || rno fddress Book

Fax Mumber:  [dap.ifas.com

E-tdail:

Tip

The default address book in the “Data Source” can be set by selecting [View] - [Default
Configuration] - [Data Source] from the menu bar.

3 Display the Detail Setting tab and select a field to search in the
“Field Select” drop down box.

x
Data Source: IF'uinc: Address Book j

Person  Detail Setting |

Define Condition:

Field Select: Condition of search string:
Dizplay Mame j IEontains j I

Fax Humber
Email Address Add

First Mamne Er—
Delete | LI

Ston |
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Select how it searches contacts in the “Condition of search string”
drop down box.

Field Select: Condition of search string:
IDispIay Mame j IEontains j |

Condition list:

Iz _—
Starts with Add
Ends with

Delete | ﬂl
Stop |

Contains — Select this to search contacts that contain the search string.

Is — Select this to search contacts that completely match the search string.
Start with — Select this to search contacts that start with the search string.
End with — Select this to search contacts that end with the search string.

Enter the search string in the next field to the “Condition of search
string” drop down box.

Field Select: Condition of search string:
IDispIay Mame j IEontains j IUser
Condition list:
Add
Delete | ﬂl
Ston |
Click [Add].

Specified search condition is added to the condition list.
Tip
If you want to clear entered values, click [Clear All].

Repeat the procedure from Step 3 to Step 6 to add all required con-
ditions.

Field Select: Condition of search string:
IDispIay Mame j IEontains j IUseri
Condition list:
Dizplay Mame Contains Jser Add |
Delete | Iﬂl
Stop |
Tip

You can remove the search conditions you have added. To do this, select the condition
and click [Delete].
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8 Click [Search].
xl

DetaSowce: | Public Address Book, =l

Person  Detail Setting |

Defing Condition:

Field Select Condion of seaich string
[Display Name x| [Contains =10

Candition list:
Dizsplay Mame Contains Lser Ldd

Dotz _ Seach |

St |

Giroup Name | Display Name [ FaxMumber [ Emal Address -
User User01 00000000001 userl1@ifax com |
User Usei01 00000000001 wserll Gifas com
User User02 00000000002 userl2@ifax com
User Usei2 00000000002 wserD2@ias com
User User03 00000000003 userl3Difax com =
. Noirm renosennes - ;l_l

e | Close | Hep |

It begins searching contacts in the selected address book. When it completes searching,
found contacts appear in the list at the bottom of the dialog box.

Tip

If you want to stop searching, click [Stop].

Converting the address book data

The address book data conversion function allows you to convert the address book data of the
TopAccess Controller Il (GL-1010) and the TopAccess Controller 1l (GL-1020) into a file format
which can be used in this equipment.

Address book converter file (*.abc) to TBF file (*.tbf)

The address book converter allows you to convert the address book data files in the address
book converter file format (*.abc), which have been created using the backup functions of
the TopAccess Controller (GL-1010) or the TopAccess Controller Il (GL-1020), into a TBF
format. You can register the address book data into this equipment by restoring these TBF
files. For the restoring procedure, see the following page:

P.105 “Converting from an address book converter file”

CSV files (*.csv) to CSV files (*.csv)

You can convert the address book data in a CSV format, which have been created using the
TopAccess Controller (GL-1010) or the TopAccess Controller Il (GL-1020), into another CSV
format which can be exported to this equipment.

P.107 “Converting from a CSV file”

The Address Book Converter can be launched only on Windows NT 4.0, Windows 2000, Win-
dows XP, and Windows Server 2003.
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Converting from an address book converter file

1 Click the [Tools] menu and select [Converting].

RIS
File Edit View | Tools Help
LDAR Setting
28 DeviceSeting  |O® 52 02 ¢=
Converting
Display Hame [ Fa Mumber | Email Addiess -
T ] Lser Lzl 00000000001 userD1 @itar com
ublic Address Book = 000000000 userD @ifas.com
4P| Addvess Book 00000000002 user02@ifax. com
5 utiock Addrsss Book B User serl2 00000000002 userl2ifar com
Dap Address Book B User Userd3 00000000003 userd3@ifar com
mpott ddisss Book B User Usenl3 00000000003 user03@itax.com
=] User User4 00000000004 useDd@itar com
B User Userd 00000000004 useil4Gifar. com
(B User serls 00000000005 usel5@itar com
B User Userls 00000000005 user5G@ifar com
=] User Userl6 00000000006 welE@iancom |
=] User User0G 00000000005 userlBGifar com
(B User User? 00000000007 useD7@itar com
B User User? 00000000007 user7 Gifar. com
(B User Usera 00000000008 useiDB@itar com
B User Userl 0000000005 userlG@ifar com
=] User Userd 00000000009 userI@itar com
B User User 00000000003 userl3Gifar com
B User Usern 00000000010 user1 0@itax com
ﬁl?‘ Hser Hserin NN N nser] NiEifaw ~om I —"LI
[irwokes the Address Baok Converter [The tatal number of the contacts: 322000

The Converting AddressBook dialog box appears.

Click [Browse] at the next of the “Input file” field.
=

- Source File,

Input file:

Erowse

Machine Type:
|GL1010 V20,0 o later) =l

W

- Diestination File:

Qutput File:

Browse
Covert | Cancel | Hep |

3 Locate the folder that contains the address book converter file
(*.abc). Select “ABC (Address Book Converter) (*.abc)” in the “Files
of type” drop down box, select the file, and click [Open].

2%
Look in: | (=4 ADDRDAT ERE= =

040413_164810.8bc

File name;  [adisbook_040413_164810.50c Open |
Files of type: [ABC [Address Book Converter] [abc) =] Cancel

v
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Select the model name that the selected file is originally created
from in the “Machine Type” drop down box.

x

- Source File

Input i

E:\My DocumentshDDRDATAVadrsbook_040413_164810.abe: Erowse

Machine Type:

[GL1010 =]

Olutput Fie

Browse
Covert | Cancel | Hep |

5 Click [Browse] at the next of the “Output File” field.

x

~Source File

Input file:

E: 4y Documents\ADDRDATAadrsbook_040413_164810.abc Browse

Machine Type:

GL-
~ Dsstination File:

Output File:

Browise
Covert | Cancel | Hep |

6 Locate the folder where you want to save a converted file. Select
“TBF (Restore) (*.tbf)” in the “Save as type” drop down box and

click [Save].

Savein | 3 ADDRDATA 2 I = s e

21

Save as type: | TRF [Restore] ["tof] | Carcel
pA

Do not specify “CSV (Comma Separated Values) (*.csv)” in the “Save as type” drop down
box. The address book converter file cannot convert to a CSV file.
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7 Click [Convert].
|

[~ Source File:

Input file:
[ 341y Documents\ADDRDAT Aladisboak_D4D413_164810.abe Browse

Machine Type:
[BLA0T0 V200 or laten =

hd

~ Destination File:

Output Fis:
E-\My Documents\ADDADATAYBACKUIP_ADDROA0520 bf Browse |

Convett | Cancel | Hep |

It starts converting a file.

8 Click [OK].
51

@ Conversion complated suzcessfully, The fils has besn created.

The file is converted and saved in the selected folder.
Tip
After you convert the file, you can restore or import the address book into the equipment

using the restore or import function of the TopAccess. For instructions on how to restore
or import the address book, refer to the Setup Guide for Printing Functions.

Converting from a CSV file

1 Click the [Tools] menu and select [Converting].

Eif e-5TUDIO AddressBook Yiewer =10 x|
File Edit View | Tools Help
LDAP Setting
= & Devicesettng |B® @ @ =
0%HI Display Name [ Fax Number | Email Address -
(= User Userdl 00000000001 userll| Gifar.com
Public Address Book B User Userll 00000000001 userd] @ifax com
MAPI Address Book B User User2 00000000002 useD2@iar com
MS Outlook Address Baok B ser sz noonooonnnZ LseD20@it s som
LDAP Address Baok B User Userdz 00000000003 Use03@itar.com
Impart ddress Bosk B User Usei3 00000000003 user03@itar com
= User Userd 00000000004 useilifar. com
(= User serla 00000000004 userDd@itar com
= User Userls 00000000005 userl5@ifar. com
(B = User sl 0000000005 userl5@itar com
= User Userls 00000000006 werlB@iascom |
(B = User sl 00000000006 userDB@itar com
B User User? 00000000007 userl7Gifar. com
(B User Userl? 00000000007 use07@itar com
B User Userla 00000000005 useilG@ifar.com
(B User Userla 00000000008 user0B@itar com
B User User 00000000009 user03Gifar com
B = User User 00000000009 userI@itar com
00000000010 user] 0ifar.com
nNOnnnNNmn naar] @iz ~nm I —>'LI
[1vokes the Address Book Converter [The total number of the contacts: 32/2000

The Converting AddressBook dialog box appears.
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2 Click [Browse] at the next of the

Converting AddressBook

“Input file” field.

x|

~Source Fis
Input file:
] Browse
Machine Type:
[BLA0T0 V200 or laten =
~ Destination File:
Output Fis:
Browse
Corvet | Cancel | Hep |

Locate the folder that contains the CSV file. Select “CSV (Comma
Separated Values) (*.csv)” in the “Files of type” drop down box,

select the file, and click [Open].
| « @ ek B

21

Look in: | (=3 ADDRDATA

b5 GL_ADDRESS_12052004_1

File name: |GL_ADDRESS_19052004_170656.csv

Open |
Files of type: [CSV (Comma Separated Values) ['csv] x| Cancel
pA

Select the model name that the selected file is originally created
from in the “Machine Type” drop down box.

Converting AddressBook

[~ Source File:

x|

Input file:
|41 Documents\ADDRDATANGL_ADDRESS 1305200417056, csv

Machine Type:
[GL10D

Browse

V2 o |ater
others)

GLAOZOEY
Output Fils:

Erowse

Corvet | Cancel Help

Converting AddressBook

[~ Source File:

5 Click [Browse] at the next of the “Output File” field.

x|

Input file:
E.\My Documents\ ADDRDATANGL_ADDRESS_13052004_1 70856.c5v

Browse

~ Destination File:

Output Fis:

Erowse

Carvert I

Cancel

Help
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6 Locate the folder where you want to save a converted file. Select
“CSV (Comma Separated Values) (*.csv)” in the “Save as type” drop
down box, enter the file name in the “File name” field, and click
[Save].

Savein | 3 ADDRDATA 2 I = s e
GL_ADDRESS_19052004_170858.csv
File name:  [ConverAddressBook Save |
Save as type: [CSY (Comma Separated Values) ['csv] x| Cancel
pA

Do not specify “TBF (Restore) (*.tbf)” in the “Save as type” drop down box. The CSV file
cannot convert to a Restore file.

7 Click [Convert].
|

- Source File,

Input file:
E:\My DocumentshDDRDATAVGL_ADDRESS_13052004_170656 cav Browse

Machine Type:

|GL1010 V20,0 o later) =l
- Destination File:
Dlutput File
E-My Dacuments ADDRDATE ConvertbddressBadk. cov Browss |

Covert | Cancel | Hep |

It starts converting a file.

8 Click [OK].

TOSHIBA Address Book x|
@ Conversion completed successfully, The file has been created.

The file is converted and saved in the selected folder.
Tip

After you convert the file, you can restore or import the address book into the equipment
using the restore or import function of the TopAccess. For instructions on how to restore
or import the address book, refer to the Setup Guide for Printing Functions.
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APPENDIX

This section shows the cover sheet samples.

Cover Sheet SAMPIES ..o e 112
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Cover Sheet Samples

Standard cover page

FACSIMILE TRANSMITTAL

Reference Number:
0000000000000000
To:
00000000001
From:
MFP-00C67861
Subject:
N/W-Fax Document

Message:
This is a N/W-Fax Document.
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Business cover page

FACSIMILE TRANSMITTAL SHEET

Reference Number:
0000000000000000
To:
00000000001
From:
MFP-00C67861
Subject:
N/W-Fax Document

Message:
This is a N/W-Fax Document.

.

Cover Sheet Samples 113
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Professional cover page

FACSIMILE TRANSMITTAL SHEET

Reference Number:
0000000000000000
To:
00000000001
From:
MFP-00C67861
Subject:
N/W-Fax Document

Message:
This is a N/W-Fax Document.

114 Cover Sheet Samples
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